
A How to for Windows Updates in Windows 10 

Windows 10 includes a feature called Action Center. This is where you see notifications about the 
items needing attention on your PC, as well as a section with quick actions that you can initiate. 

 

You open the Action Center by clicking on its icon in the Notification area found at the extreme right 
end of the taskbar. Up to 13 different buttons are available, but many like Rotation lock, Airplane 
mode and Bluetooth will only appear on portable devices like laptops or tablets. 

To configure the Quick actions buttons on the Action Center, open the Settings app. To do this, you 
can either open the Action Center and click on the “All Settings” button. Most of the settings you'll 
want to change in Windows 10 are in All Settings section. 

 



or you can open the Start menu and click the “Settings” button on the lower-left side of the menu. 

 

Windows settings is organized into various categories: System, Devices, Network & Internet, 
Personalization, Apps, Accounts, Time & language, Ease of Access, Privacy, and Update & 
security. You click on a category to view and change more settings for that category.  

Settings in Windows 10 – alternatively use Win () + I key combination. 

 

https://www.tenforums.com/attachments/tutorials/118739d1485549144-settings-open-windows-10-a-settings.png


The Settings app from Windows 10 holds almost all the settings governing the way your computer or 
device works. The traditional way of getting to one setting or to another is to open the appropriate 
settings category and browse through it until you find what you’re looking for. The Setting app from 
Windows 10 is very well organized, a lot better than the old Control Panel used to be. Inside, you’ll 
find separate categories for: 

 System - settings that allow you to control the display options, configure notifications, 
manage apps and manage power options. 

 Devices - allows you to change all the settings related to the devices you have connected to 
your Windows 10 computer or device, including Bluetooth devices, printers, scanners, the 
mouse and keyboard and so on. 

 Network & Internet - these settings allow you to configure your Ethernet and wireless 
adapters. There are also settings for the virtual private networks and the proxies that you use. 

 Personalization - from here you can change the Desktop Background, the Lock screen, the 
Taskbar, the colors used by Windows 10, as well as the way the Start Menu looks and works. 

 Accounts - has the settings related to your personal account and information, sign-in options 
and syncing settings. 

 Time & Language - is where you can change the date and time, the region you live in and the 
language you use, and where you can set up the speech options. 

 Ease of Access - controls the Narrator and Magnifier tools, as well as other options such as 
the High contrast or Closed captions settings. 

 Privacy - lets you set what information can Windows 10, apps or third party services access 
and use. 

 Update & Security - gives you access to the settings that govern the way Windows 10 
updates itself, it lets you control how Windows Defender protects you, and it lets you access 
the backup and recovery options found in Windows 10. 

http://www.digitalcitizen.life/how-quickly-find-any-setting-settings-app-windows-10 

On the Settings dialog box, click the “System” icon. 

http://www.digitalcitizen.life/how-quickly-find-any-setting-settings-app-windows-10


 

Click “Notifications & Actions” in the list of options on the left. 

 



Configure the Quick Actions Buttons 

To rearrange the Quick actions buttons, simply drag and drop them in the order you want. The four 
buttons on the top row make up the hot-bar and are available even when you collapse the buttons. 

 

Now that we’ve rearranged some of the buttons, we want to remove a few. So, we click the “Add or 
remove quick actions” link under the button layout. 



 

A complete list with on/off switches of all the available Quick actions buttons displays including: 

settings like Location, the option to turn on Tablet Mode, or connect to an available Bluetooth device 
in the area. To turn off a Quick action button, click the slider button to the right of the Quick Action 
button name so it turns white and reads Off. 

The changes you make are effective immediately, so you do not need to sign out or reboot your PC.  

(see screenshot below) 



 

To close the Settings dialog box, click on the “X” in the upper-right corner. (see screenshot below). 



 

Expand and Collapse the Quick Actions Buttons 

The Quick actions buttons at the bottom of the Action Center reflect the changes you made in the 
settings. Any buttons you don’t select for the hot-bar (the top row) will automatically be shoved down 
to the full menu, which can be expanded in the action center by clicking the “Expand” link. 

 

The rest of the options which weren’t already hot swapped to the first row will display. You can click 
“Collapse” to only show the hot-bar again. 



 

You can also hide the top four Quick action buttons even when the buttons are collapsed, until you 
click the “Expand” link to show them all. The Action Center can also be disabled completely. 

https://www.howtogeek.com/225345/how-to-configure-the-windows-10-
action-panel-with-your-own-customized-buttons/ 

How to display the Power User menu using your keyboard 
Press the Windows Logo key  + X 

 

https://www.howtogeek.com/255222/how-to-hide-the-quick-action-buttons-in-windows-10s-action-center/
https://www.howtogeek.com/244539/how-to-disable-the-action-center-in-windows-10/
https://www.howtogeek.com/225345/how-to-configure-the-windows-10-action-panel-with-your-own-customized-buttons/
https://www.howtogeek.com/225345/how-to-configure-the-windows-10-action-panel-with-your-own-customized-buttons/


Power User menu keyboard shortcuts 

Press   To 

 + X   Open the Power User menu 

Then press  To open 

F   Programs and Features 

O   Power Options 

V   Event Viewer 

Y   System 

M   Device Manager 

W   Network Connections 

K   Disk Management 

C   Computer Management 

A   Administrative Command Prompt 

T   Task Manager 

P   Control Panel 

E   File Explorer 

S   Search (Cortana) 

R   Run dialog box 

U   Shut down or sign out 

U then I  Shut down 

U then U  Sign out 

U then R  Restart 

  



Programs and Features - This tool is used to remove installed software, but you can also use it to 
view and remove installed Windows Updates or to turn certain Windows features on or off. 

 

Power Options - Using Power Options you can change your power plan, which is rather useful if 

you’re using a laptop, change what the power button does, or set your PC or monitor to turn itself off 

after a certain time of inactivity. 

 

http://cdn.windowsreport.com/wp-content/uploads/2016/05/programs-and-features.jpg


Event Viewer - is an advanced tool that lets you see log of events that happened on your PC. You 
can use this tool to see when your PC was turned on or off, or you can use it to see when and why 
certain application crashed. Event Viewer is one of more complex tools on our list, and it’s and due 
to its complexity, it might not be suitable for basic users. 

 

System - using this shortcut you can see some of the basic system information, such as the version 
of Windows 10 that you’re running, amount of RAM or the CPU that you’re using. 

 

http://cdn.windowsreport.com/wp-content/uploads/2016/05/event-viewer.jpg
http://cdn.windowsreport.com/wp-content/uploads/2016/05/system.jpg


Device Manager is a tool we mention and use rather often. This tool will allow you to view all your 
installed devices and uninstall or update their drivers. In addition, Device Manager allows you to 
change the properties of installed devices, so it can be rather useful tool. 

 

Network Connections - will allow you to see all network adapters on your PC. By using this 
shortcut, you can easily change the properties of your network adapter or even disable it completely. 

 

http://cdn.windowsreport.com/wp-content/uploads/2016/05/device-manager.jpg
http://cdn.windowsreport.com/wp-content/uploads/2016/05/network-connections.jpg


Disk Management - allows you to create new partitions or to change the size of hard drive 
partitions. This tool can delete entire partitions, so be extra careful if you’re going to use it. 

 
Computer Management - lets you access many hidden Windows 10 features. You can even use 
Computer Management to access some tools that are available in Power User Menu. Since this tool 
can access many other advanced features and tools, you should be careful if you’re going to use it. 

 

http://cdn.windowsreport.com/wp-content/uploads/2016/05/disk-managment.jpg
http://cdn.windowsreport.com/wp-content/uploads/2016/05/computer-management.jpg


Command Prompt and Command Prompt (Admin) - are the same tool, but come with different 
privileges. They come in a form of command line, and you use it to create files, delete folders, check 
your network adapter properties, create new users, or even format your hard drive. 

 
There are countless ways you can use Command Prompt, but not all, of the advanced features, are 
available in regular Command Prompt. You must use Command Prompt (Admin) that has full 
administrator privileges. 

Next is Task Manager - You can use Task Manager to view all your currently running applications 
and close them instantly if they stop responding. In addition, you can set which applications will start 
alongside Windows 10 every time you start your PC. 

 

http://cdn.windowsreport.com/wp-content/uploads/2016/05/command-prompt.jpg
http://cdn.windowsreport.com/wp-content/uploads/2016/05/task-manager.jpg


Control Panel - you’re probably familiar with and you know that you can use it to change almost 
any setting on your PC. 

 
File Explorer and Search - options don’t offer access to any advanced features, instead they work 
as shortcuts to File Explorer and Search. 

Run option - will open a Run dialog that allows you to run almost any application from your PC. You 
can use this feature to run tools such as Command Prompt or Registry Editor by simply entering the 
name of the file in the input field. 

 
Shutdown or sign out option allows you to quickly turn off or restart your computer, so you might use 
this option from time to time. Last option on our list is Desktop, and by using this option you will 
minimize all open windows and instantly show your Desktop. 

As you can see, Power User Menu offers shortcuts to some of the most used and most powerful 
features on Windows 10. It’s also worth mentioning that you can access any of these options by 
using a simple keyboard shortcut. When you press Windows Key + X shortcut, you should see 
Power User Menu, and each option on the list will have an underline under a certain character, and 
you can simply press that character on your keyboard to quickly access a specific tool. For example, 
if you press Windows Key + X and then press T, you’ll open Task Manager. These shortcuts are 
available for all options on the list, thus making these features easier to access. 

Power User Menu is rather useful and it can be used to access many tools and features of Windows 
10 quickly. Bear in mind that some of these tools are rather powerful, so use them with caution. 

http://cdn.windowsreport.com/wp-content/uploads/2014/07/control-panel-options.png
http://cdn.windowsreport.com/wp-content/uploads/2016/05/run.jpg


How to Enable and Use Panes in Windows 10 
by Ciprian Adrian Rusen 

Windows 10 allows you to enable different panes to make the most of your user experience. The 
different panes include: The Preview pane, the Details pane, and the Navigation pane. Here, you 
find details about enabling and using each of these panes. 

Enable and Use the Preview Pane 

In File Explorer, you can enable a Preview pane that is shown on the right side of the window. As 
the name implies, you can use it to preview the contents of certain types of files. For example, if you 
select an image file in File Explorer, you can see a preview of it; if you select a text file, you can 
preview its contents. 

 
The Preview pane in File Explorer. 

You can see previews of only certain file types: text, images, and videos. 

To enable the Preview pane, open File Explorer and follow these steps: 

1. In the File Explorer window, click the View tab. 
 The View tab is shown. 

2. In the Panes section, click the Preview Pane button. 
 The Preview pane is added to the right side of the File Explorer window. 

3. To preview a file just select it by clicking on it (it will then be highlighted). 

You can preview their contents in the Preview Pane, if they are text, images, or videos. 

http://www.dummies.com/?s=&a=ciprian-adrian-rusen


 
Enabling the Preview pane in File Explorer. 

To disable the Preview pane, just follow the preceding steps. 

You can also enable and disable the Preview pane in File Explorer by pressing the Alt + P keys on 

your keyboard. 

Enable and Use the Details Pane 

In File Explorer, you can enable a Details pane that is shown on the right side of the File Explorer 
window. As its name implies, you can use the Details pane to find more information about each file, 
such as its size, the date it was created, and the date it was last modified. The fields of data shown 
in this pane vary from file to file. For some files, such as pictures, you see lots of data; whereas for 
other files, such as PDF files, you see less data. 



 
The Details pane in File Explorer. 

To enable the Details pane, open File Explorer and follow these steps: 

1. In the File Explorer window, click the View tab. 

The View tab is shown. 

2. In the Panes section, click the Details Pane button. 

The Details pane is added to the right side of the File Explorer window. 

3. To see a file’s details, click it to select it. 



 
Enabling the Details pane in File Explorer. 

To disable the Details pane, just follow the preceding steps.  

You can also enable and disable the Details pane in File Explorer by pressing Alt + Shift + P Keys 
on your keyboard.  

Disable or Enable the Navigation Pane 

In File Explorer, the Navigation pane is shown, by default, on the left side of the window. As the 
name implies, you can use it to quickly jump to different locations on your computer. 

When the Navigation pane is disabled and you start File Explorer, either Quick Access or This PC is 
loaded, depending on your start location for File Explorer. 

It’s generally not a good idea to disable the Navigation pane because doing so makes navigation 
more difficult. 

If you decide to disable the Navigation pane, follow these steps: 

1. Open File Explorer. 

2. Click the View tab. 
The View tab is shown. 

3. In the Panes section, click the Navigation Pane button. 
The Navigation Pane menu appears. 

4. In the menu, click Navigation Pane. 

The Navigation pane no longer appears at the left side of the File Explorer window. 



 
Disabling the Navigation pane in File Explorer. 

To enable the Navigation pane, follow the preceding steps. 

Enable the Libraries Section in the Navigation Pane 

By default, the Navigation pane doesn’t show the Libraries in Windows 10, as it did in Windows 7. 
Fortunately, the libraries aren’t gone; they’re just hidden. To enable and use the libraries in Windows 
10, open File Explorer and follow these steps: 

1. In the File Explorer window, click the View tab. The View tab is shown. 

2. In the Panes section, click the Navigation Pane button. The Navigation Pane menu appears. 

3. In the menu, click Show Libraries. The Libraries are now added to File Explorer. 

4. Click the Libraries shortcut in the Navigation Pane to view your libraries. 

 
Enabling the Libraries section in File Explorer. 



Patch Tuesday 
Patch Tuesday is an unofficial term used to refer to when Microsoft regularly releases security 
patches for its software products.  

Patch Tuesday occurs on the second, and sometimes fourth, Tuesday of each month in North 
America. The updates show up in Download Center first. Then they are added to WU, and the  KB 
articles and Technet bulletins. 

Tuesday was chosen as the optimal day of the week to distribute software patches. This is done to 
maximize the amount of time available before the upcoming weekend to correct any issues that 
might arise with those patches, while leaving Monday free to address other unanticipated issues that 
might have arisen over the preceding weekend. 

Non-security updates to Microsoft Office tend to occur on the first Tuesday of each month and 
firmware updates for Microsoft's Surface devices on the third Tuesday of every month. 

Latest Patch Tuesday 

The latest Patch Tuesday was on January 10, 2017 and consisted of several individual security 
updates. The next Patch Tuesday was scheduled for February 14, 2017. 

It looks like the skipped security month includes more than “just” Windows. There have been no 
recent security patches for Vista, Windows 7, Windows 8.1, and Windows 10 versions 1507, 1511, 
and 1607. Also, no security patches this month for Office 2010, 2013, 2016, and the Office 365 
Click-to-Run current channel version 1611. No security patches for Internet Explorer (which was 
supposed to start getting its own security patches this month), and no .Net security patches. 

Microsoft Delays this Month’s Patch Tuesday to March 14th 
Brian Burgess | February 16, 2017 in News 

https://www.groovypost.com/news/microsoft-delays-this-months-patch-tuesday-to-march-14th/ 

Apparently in anticipation of a Patch Tuesday that never happened, Microsoft pulled the two 
snooping patches it released last week, KB 2952664 (Windows 7) and KB 2976978 (Windows 8.1). 
KB 2952664 is not available in the Microsoft Update Catalog, and the KB 2976978 that is available 
in the Update Catalog is from July 2016. 

Microsoft Edge is exposed to new vulnerabilities in Adobe Flash Player. Supported browsers like 
Chrome or Firefox that have their own auto-updating mechanisms should already be patched. But 
Microsoft Edge only gets updated by its normally regular Patch Tuesday. 

As a side note, to verify you have the latest patched version Adobe Flash Player, in the Chrome 
address bar type: chrome://components and verify you have version 24.0.0.221 – if the version is 
lower, click the button to check for update.  

https://en.wikipedia.org/wiki/Microsoft
https://en.wikipedia.org/wiki/Knowledge_base
https://technet.microsoft.com/en-us/mt465751
http://www.infoworld.com/article/3158858/microsoft-windows/signs-point-to-microsofts-imminent-release-of-windows-7-service-pack-3.html
https://www.groovypost.com/howto/author/brian/
https://www.groovypost.com/news/
https://www.groovypost.com/news/microsoft-delays-this-months-patch-tuesday-to-march-14th/
http://www.infoworld.com/article/3168397/microsoft-windows/microsoft-re-releases-snooping-patches-kb-2952664-kb-2976978.html
http://www.catalog.update.microsoft.com/search.aspx?q=kb2952664
http://www.catalog.update.microsoft.com/Search.aspx?q=KB2976978
https://helpx.adobe.com/security/products/flash-player/apsb17-04.html
https://get.adobe.com/flashplayer/?no_redirect


 

  



How to View Windows Update History in Windows 10 

By default, Windows 10 will automatically check for and install available Windows Updates at the 
time you have set in automatic maintenance. Some updates are not installed automatically. This 
includes optional updates and updates that require you to accept new terms of use. When these 

updates are available, Windows Update will let you know that they're ready to be installed. 

Here's How: 

1. Open Settings, and click/tap on the Update & security icon.  

 

2. Click on the Update history link under Update status on the right side.  

3. You will now see the history of Windows Update listed in categories. (see screenshot below) 

https://www.tenforums.com/tutorials/3090-automatic-maintenance-change-settings-windows-10-a.html
https://www.tenforums.com/tutorials/3326-settings-open-windows-10-a.html
https://www.tenforums.com/attachments/tutorials/102107d1474236695-windows-update-history-view-windows-10-a-update_history-1.png


 
 Note 

You can, click on any of the "Successfully installed on" links to see more details for that update.  

You can then click on the More info link for even more details about the update, online at Microsoft. 

 

4. When finished, you can close Settings. 

https://www.tenforums.com/attachments/tutorials/102108d1474236695-windows-update-history-view-windows-10-a-update_history-2.png


Pro: Up-to-date Security 
Windows is still the most popular operating system in the world and that makes it a prime target for 
development of viruses and malicious attacks. No operating system will ever be one hundred 
percent secure and having an unstable operating system can lead to disastrous consequences. 

For example, past Windows vulnerabilities have resulted in some attackers being able to remotely 
execute codes on a system to install programs, view data, create accounts with full permissions, 
and more. Of course, these types of incidents are considered critical level and Microsoft does 
release patches for them as soon as possible. Providing Windows Update isn’t disabled on a current 
system, this is how it works at present. 

Continuing this practice, along with taking it one step further to ensure that critical updates can’t be 
dismissed, is excellent news. Having unsecure systems out there is bad for Microsoft and the end 
user, and it’s vital that any known flaws are patched up as soon as possible. This will mean that 
attacks can be shut down quicker and less users will end up having their systems compromised. 

 

Con: Botched Updates 
While most updates do go successfully, some of them have been shown to cause more harm than 
good. Past problems vary from the minor to major: input lag on some games, broken playback on 
specific video file types and even a full blue screen of death. While Microsoft, acknowledges and 
resolves these problems it was an inconvenience that users shouldn’t have had to go through. If 
Windows 10 forces updates on everyone, how can we be sure that they will always be stable? 

All Windows 10, updates will first be processed by a group of Windows Insiders (Insider Program). 
These “Insiders” will test the updates to make sure they’re decent, before they’re rolled out onto all 
Home computers. That group of Insiders are initial the guinea pigs, until the updates are then rolled 
out to Enterprise users. Theoretically, that first round of checks should remove any problems, but 
things don’t always work that way in practice. 

http://www.makeuseof.com/tag/a-look-at-some-of-the-worst-computer-viruses-in-history/
http://www.makeuseof.com/tag/windows-8-crashing-easily-troubleshoot-blue-screen-issues/
http://www.amazon.com/Microsoft-Windows-10-Home-Download/dp/B01019BM7O/ref=as_at?tag=mak041-20&linkCode=as2
http://www.amazon.com/Microsoft-Windows-10-Home-Download/dp/B01019BM7O/ref=as_at?tag=mak041-20&linkCode=as2


While it’s true that the most current updates go by without a hitch, and we perhaps shouldn’t damn 
the process before we’ve even tried it out, it is slightly concerning. If an update turns out to be 
botching people’s systems, there’ll be no way for Home users to get out of it unless the update is 
recalled or patched quickly. Whereas on-the-ball users can currently read about a troublesome 
update and skip it, this won’t be a choice come Windows 10. Note, even Apple gives you a choice. 

 

Pro: Unified Development 
Development can be hard when there’s so many different operating versions to account for. It’s like 
the battle that web developers face when ensuring their sites work across all the different browsers. 
While a program can work smoothly on Windows 8, that doesn’t mean it’ll be the same on Windows 
7 – and vice versa. Forcing updates will mean that all systems are running the same framework and 
it’ll make the life of a developer that bit easier. 

This is great for end users too because it’ll mean there’s greater cross-compatibility, at least from an 
operating system point of view (hardware, drivers and all that jazz are a different ball game). With 
Microsoft’s mobile/Xbox platform joining the Windows 10 ecosystem, it means you’ll be able to do 
things like stream Xbox One games to your computer. All of this is made easier because the 
framework is consistent across all the platforms. No longer will your Windows devices be separate.  

Con: Reduced Flexibility 
Windows 10 will be the last version of Microsoft’s operating system. Whereas in the past the launch 
of the latest version of Windows was a big event, consumers are now wired to expect their updates 
to be free, thanks to companies like Apple and Google. As such, the idea is that everyone will just 
be running Windows as a service. Think of an online site you use, like Facebook, which continues to 
evolve while still maintaining the same name and lacking version numbers. This is what Microsoft 
now sees Windows as being like. 

http://www.makeuseof.com/tag/heres-gaming-will-work-windows-10/
http://www.makeuseof.com/tag/windows-10-last-version-windows-ever/
http://www.makeuseof.com/tag/priority-windows-10-news-briefing-summary/


To an extent, users have flexibility over their flavor of Windows. There are some people who are still 
sticking with XP, despite official support for it having ended, simply because they prefer it over the 
subsequent operating systems. There’s people out there who don’t upgrade their operating systems 
purely because they’ve got used to what they know and it’ll be too much of a hassle to learn their 
way round a new system. With Windows 10, there won’t be any choice about what features you 
install or future aesthetic changes you approve. Everyone will have the same features, whether they 
want or like it or not. 

To Update or Not to Update? 
With Windows 10, which numerous users have already opted into upgrading to, that won’t be the 
question: you’ll have no choice. Those who want a bit more flexibility over their updates must move 
from Windows 10 Home to the more expensive Windows 10 Pro option. But should that be the 
case? Surely updating should be our choice? 

Maybe not. Microsoft wants to keep all systems in sync and unified. Ensuring that everyone is 
running the same version of their operating system will make life easier for them and hopefully more 
secure for us. While Pro has advantages over Home, I suggest use the OS the computer came with. 

Which Windows 10 should your install? 
By Eric Knorr | Editor in Chief | InfoWorld |Feb 13, 2017 

In one sense, Windows 10 is the “end of history.” There will be no Windows 11 — or 12, were 
Microsoft to decide to keep skipping odd numbers. Windows 10 is it! 

Windows 10 changes all the time. Constant updates can’t really be escaped by Home version users, 
whereas admins mete out updates for Pro/Enterprise users who are attached to an update server. 

There are several major versions of Windows 10: 1507 (RTM), 1511 (Fall Update), 1607 
(Anniversary Update), and 1703 (“Creators Update”). This raises a big question: If you’re running a 
business, which of these versions of Windows 10 should you deploy? Here are the basics: 

 For business use, you want the CBB (Current Branch for Business) servicing option. Not some 
Insider Ring beta, of course, nor just a CB (Current Branch). The CBB is what you need because 
versions designated “CBB” have been put through the wringer — many months on millions of users’ 
computers — to shake out the bugs. Think of the CBB as the result of a massive unpaid beta testing 
cycle. Right now, 1507, 1511, and (late November) 1607 have been granted CBB status. 

 Just last week Microsoft announced that version 1507, the first-ever Windows 10 launched on Jul. 
29, 2015, would go off support in May. You should not be running this version. If you’ve managed to 
block updates to 1507 to prevent it turning into a later version, stop that right now. It’s unfinished 
and not particularly stable. Upgrade! 

 Version 1511, which was granted CBB status on Apr. 8, 2016, is pretty much the same deal as 
1507. It’s an old and incomplete version. Our best guess is that it will go off support in early 2018. 
Time to update sooner rather than later. 

 Version 1607, the so-called Anniversary Edition, is today’s Windows 10 gold standard. Microsoft 
released it on Aug. 2, 2016, and granted it CBB status on Nov. 29, 2016. This is the last Windows 
10 version that InfoWorld has reviewed — and it actually earned a 2017 InfoWorld Technology of 
the Year Award, primarily for its omni-device management. 

 Version 1703, the Creators Update, is currently in beta but should be available in a couple of 
months. It’s anybody’s guess when 1703 will reach CBB status, but figure on four months or so after 
release. You’ve probably heard about the features that give this version its name, such as the 
drafting features that work hand in glove with Microsoft’s new Surface Studio, Redmond’s first all-in-
one desktop. As InfoWorld’s Galen Gruman has said, Microsoft is reaching for Apple’s creative 
crown. But at the same time, the Creators Update promises improved security, better device 
management, and greater admin control over updates. 

http://www.makeuseof.com/tag/upgrade-windows-10-via-windows-update/
http://www.infoworld.com/author/Eric-Knorr/
http://www.infoworld.com/article/2613504/microsoft-windows/microsoft-windows-microsoft-skips-too-good-windows-9-jumps-to-windows-10.html
https://blogs.technet.microsoft.com/windowsitpro/2017/01/19/windows-10-v1607-media-now-available/
http://www.infoworld.com/article/3097514/microsoft-windows/review-windows-10-anniversary-update-fails-to-excite.html
http://www.infoworld.com/article/3160526/application-development/infoworlds-2017-technology-of-the-year-award-winners.html#slide31
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http://www.itworld.com/article/3135781/windows/these-are-the-3-big-reveals-from-microsofts-surface-event.html
http://www.infoworld.com/article/3135269/macs/as-apple-fiddles-microsoft-reaches-for-apples-discarded-creative-crown.html
http://www.infoworld.com/article/3135269/macs/as-apple-fiddles-microsoft-reaches-for-apples-discarded-creative-crown.html


As InfoWorld and others have pointed out, the improved security of Windows 10 alone provides 
ample reason to upgrade to Windows 10. Just make sure that, at this juncture, you’re running the 
Anniversary Update. You might also make a habit of checking Woody Leonhard’s blog regularly to 
see which problematic patches and updates he has flagged this week. 

One final note: If you’re super-conservative, you might want to consider the LTSB (Long-Term 
Servicing Branch) servicing option. This is the slowest-moving branch of Windows 10. You get 
security and bugfix updates automatically, but not feature updates, and you need to install new 
versions manually. The Anniversary Update 1607 has been granted LTSB status; we don’t know if 
Creators Update will ever be given LTSB status (1511 never made LTSB). 

Microsoft sees LTSB as being for mission-critical systems only — after all, labor-intensive updates 
defeat the ability to deliver the latest features quickly. But if you want to avoid disruption at all costs, 
it’s worth considering. At this point, there are two LTSB versions of Win10, called LTSB 2015 and 
LTSB 2016. You may be tempted to think of them as analogous to regular versions of Win10, but 
they're not. Security patches for the LTSB versions of Win10 continue for 10 years after the product 
rolls out. You can't use those security patches on other versions of Windows. 

http://www.infoworld.com/article/3168924/microsoft-windows/which-windows-10-should-your-business-install-this-
one.html?idg_eid=61438d78abdb854e5ec47e3595ae94b8&email_SHA1_lc=ded406c1283ee82830aa784e525e1412bb
e171d1&utm_source=Sailthru&utm_medium=email&utm_campaign=InfoWorld%20Daily:%20Afternoon%20Edition%202
017-02-13&utm_term=infoworld_daily 

PC Version History 

Version 1507 

Windows 10 Version 1507 (build 10.0.10240), codenamed "Threshold 1", was the first release of 
Windows 10. It‘s build number was 10.0.10240; while Microsoft has stated that there was no 
designated "RTM" build of Windows 10, 10240 has been described as an RTM build by various 
media outlets. It has been retroactively named "version 1507" by Microsoft per its naming 
conventions for future stable releases of the operating system. The final release was made available 
to Windows Insiders on July 15, 2015, followed by a public release on July 29, 2015. As of August 
2, 2016, the Threshold 1 release was the only release in the Long-Term Servicing Branch (LTSB). 

Commonly referred to as "Day One Patch", this is the first general availability build. It is the update 
users received when they upgraded to Windows 10 through the free upgrade offer or after checking 
for updates on PCs preloaded with Windows 10. 
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Version 1511 (November Update) 

Windows November 10 Update, or Windows 10 Version 1511 (build 10.0.10586), codenamed 
"Threshold 2", was the first major update to Windows 10. It’s build number is 10.0.10586 and is 
version 1511, referencing its date of release, November 2015. The first preview was released on 
August 18, 2015. The final release was made available to Windows Insiders on November 3, 2015, 
followed by a public release on November 12, 2015 to existing Windows 10 users, and as a free 
upgrade from Windows 7 and Windows 8.1. Unlike the initial release of Windows, this branch was 
also made available to existing Windows Phone 8.1- devices and the Xbox One and as a preview 
release to Windows Server 2016, and was pre-installed on new Windows 10 Mobile-devices like the 
Microsoft Lumia 950. The Threshold 2 release of Windows 10 is supported for users of the Current 
Branch for Business (CBB). 

Version 1607 (Anniversary Update) 

Windows 10 Anniversary Update, or Windows 10 Version 1607 (build 10.0.14393), codenamed 
"Redstone 1", was the second major update to Windows 10 and the first of the 4 major updates 
planned under the Redstone codenames. It carries the build number 10.0.14393 and version 1607. 
The first preview was released on December 16, 2015. It was released to the public on August 2, 
2016. The Redstone 1 release of Windows 10 is supported for users of the Current Branch (CB) and 
the Long-Term Support Branch (LTSB) 

Microsoft is experimenting with a new tool that allows you to get a clean Windows 10 system. The 
“Reset your PC” option just resets your PC to its manufacturer default settings, and many PC 
manufacturers include a lot of junk on their PCs. You can always reinstall Windows 10 yourself, but 
you must download installation media. To make getting a clean Windows 10 system easier there’s a 
new “Learn how to start fresh with a clean installation of Windows” option at Settings > Update & 
Security > Recovery. This currently links a Microsoft Answers forum thread where you can download 
a tool that walks you through the Windows 10 reinstallation process. 

It’s easier to get to the Action Center. The Action Center button is now located in the extreme right 
corner of the taskbar, making it easier to find. It’s no longer mixed in with the other system tray 
icons. Notifications are now grouped by app in the Action Center. They’ll take up less screen space, 
and you can see more notifications at once. 

Windows 10’s Anniversary Update includes many more changes than these, with small 
enhancements and bug fixes everywhere. Here are some of the more interesting changes: 

 The “blue screen of death” that appears when your Windows PC freezes now features a QR 
code, allowing you to more quickly search for the error with your phone. 

https://en.wikipedia.org/wiki/Windows_Phone_8.1
https://en.wikipedia.org/wiki/Xbox_One
https://en.wikipedia.org/wiki/Windows_Server_2016
https://en.wikipedia.org/wiki/Windows_10_Mobile
https://en.wikipedia.org/wiki/Microsoft_Lumia_950
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Microsoft is adding QR codes to its Blue Screen of Death (BSOD). It's the biggest change to the 
BSOD since the software maker removed a lot of crash details in Windows 8 and replaced them 
with a frowning face. The new QR codes are featured in the latest preview of Windows 10, and 
debuted this past summer as the Anniversary Update. 

Microsoft is using the QR codes to help support technicians identify error codes in the blue screens, 
and for Windows 10 users to quickly scan them from a phone to find support articles and assistance. 
BSOD's have often been complicated to understand, and difficult to use to identify the root cause of 
an issue, but this simplified approach could help Windows 10 users troubleshoot any system issues.  

 The Settings app has seen an overhaul. Each page in the Settings app now has a unique icon. 
Pin a settings page to your Start menu and it’ll use that unique icon.  

 Activation has been tweaked. A “digital entitlement” your hardware received if you took 
advantage of the free Windows 10 upgrade offer is now known as a “digital license”. If you sign 
in with your Microsoft account, the entitlement will be associated with your Microsoft account 
offline. If you need to re-activate Windows 10 in the future (hardware change), the activation 
wizard will use your Microsoft account to re-associate the digital license with your hardware. 

 You can now reset apps (which works by clearing an app’s cache data) on Android devices. 
Head to Settings > Apps and features, select an app, and select “Advanced options”. This same 
screen allows you to remove “add-ons” and downloadable content associated with apps. 

 The Windows Game Bar, which allows you to control the Game DVR feature for recording 

videos of your gameplay, has been updated with support for more full-screen games. Just press 
Windows + G on your keyboard while playing one of these new games to bring it up. 

 The Xbox app now provides “game hubs” for the top 1000 most popular Windows desktop 
games, so it’s more integrated with the games people are playing on PCs. They’ll appear in 
Xbox activity feeds, too. 

 Many accessibility features were improved, with faster text to speech, new languages for text to 
speech, and various improvements to apps like Edge, Cortana, Mail, and Groove. 

 When you need to enter credentials, Windows will now allow you to choose Windows Hello, a 
PIN, a certificate, or a password. 

http://www.howtogeek.com/222141/how-to-pin-your-favorite-settings-to-the-start-menu-in-windows-10/
http://www.howtogeek.com/219947/how-to-record-pc-gameplay-with-windows-10%E2%80%99s-game-dvr-and-game-bar/
https://blogs.msdn.microsoft.com/accessibility/2016/07/01/making-progress-on-accessibility-with-the-windows-10-anniversary-update/


Version 1704 (Creators Update) 

Windows 10 Creators Update or Windows 10 Version 1704, codenamed "Redstone 2", is the third 
major update to Windows 10 and the second of the 4 major updates planned under the Redstone 
codenames. The first preview was released to Insiders on August 11, 2016. 

The Windows 10 Creators Update is due to hit PCs in April, 2017. Like other updates to Windows 
10, it’s free, and includes a host of new features. 

Whats New in Windows 10 Update in the Creators Update 
Andre Da Costa | February 5, 2017  

The Windows 10 Creators Update introduces new changes to the Windows Update service for 
select editions of the operating system. This is excellent news for Windows Home Edition as they 
are configured by default to download and install every update the software firm releases. The 
objective is to keep users secure and resolve problems quickly. The Anniversary Update, launched 
in August 2016, gave Windows 10 Home users more flexibility, with options such as active hours 
and restart options. This resolved complaints from users regarding forced restarts that can 
sometimes occur without the user’s consent. 

For higher editions of Windows 10 such 
as Pro, Enterprise, and Education, the 
Creators Update is now giving those users 
some love. 

A common frustration with Windows 
Update in Windows 10 is the reliability of 
the service. Because of my bandwidth 
issues, You have to customize Windows 
10 to prevent Windows Update from 
downloading large updates on a metered 
connection. In the Creators Update, 
Windows 10 Pro or higher now includes 

the option to pause updates for up to 35 days. When enabled, updates will not be downloaded for 
that that time, but virus definitions for Windows Defender will still be required. 

This is a significant concession and is workable and a very welcome improvement. 

http://www.howtogeek.com/248177/whats-new-in-windows-10s-anniversary-update/
http://www.howtogeek.com/248177/whats-new-in-windows-10s-anniversary-update/
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Speaking of big, Microsoft is doing something about those large cumulative updates too. A new 
option called the Unified Update Platform provides differential updates; instead of packing on the 
same set of updates each time with more code. Windows Updates will simply download the changes 
needed based on your system configuration; leading to smaller downloads, more reliability, better 
performance and less of the common “stuck at 0%” for an eternity. 

 

One issue with the new changes, though – and this primarily affects Windows Insiders and users 
downloading the feature update on day one – you won’t easily get that ESD file anymore. A file with 
the ESD file extension is a file downloaded using Microsoft's Electronic Software Download 
application and delivers a compressed image of the Windows 10 installation files,. That said, the 
Microsoft Software Download Page and Media Creation Tool will be able to download the 
appropriate ISO file. 

https://blogs.windows.com/windowsexperience/2016/11/03/introducing-unified-update-platform-uup/#UBCyYvvv5asfj3di.97
https://windows10.help/blogs/entry/7-download-windows-10-anniversary-update-iso-files-directly-using-your-web-browser/
https://www.groovypost.com/howto/create-windows-10-bootable-usb-flash-drive/
https://www.groovypost.com/howto/windows-10-iso-download/


Another change users should be aware of is the default behavior for how updates are delivered. The 
option to receive updates from PCs on a local network and PCs on the Internet is now enabled by 
default. If this is a problem for you, you can toggle it off. You should keep it disabled as it causes 
high CPU spikes. So, if you notice your laptop fan on constantly, this is likely the culprit. 

 

A more accessible option for including drivers updates from Windows Update is now available. 
Users might want to turn this off too if they experience problems with an offending driver delivered 
through Windows Update; especially, if the hardware device or component is working fine already. 
Previously this was buried under the old Advanced System Settings interface. 

https://www.groovypost.com/howto/stop-whats-revving-your-cpu-fan-constantly-in-windows-10/
https://www.groovypost.com/howto/prevent-automatic-driver-installation-in-windows-10/


 

For business users, Windows Update exposes previously hidden configurations for delaying feature 
updates. In the past, an Administrator could only find this setting using the Group Policy editor. Now 
it’s right there in the main interface. 

If you use Windows 10 in a domain/large organization, you can now easily toggle settings for how 
future updates are delivered. The Current Branch is probably the safest to leverage in the business. 
It will only deploy updates as they become available after Microsoft confirms they have been 
thoroughly tested and fit for production. This is likely to affect future releases of Windows 10 going 
forward such as the upcoming Redstone 3. Advanced options also provide options to delay both 
feature and quality updates up to eight days. 

https://www.groovypost.com/howto/join-a-windows-10-client-domain/


 

If you need more time, you will need to turn to the Group Policy editor or the registry to make 
modifications that can defer a feature update for up to 1 year. 



 

Microsoft does offer an official tool that can also defer feature updates if users believe their system 
is not compatible with a release of Windows 10. There is not a lot of coordination between Microsoft 
and OEM’s, so you won’t know for sure if a system is compatible with Windows 10 Creators Update 
or not unless the update tries to install and then fails. 



 

The changes are small but welcome. When combined with existing options that have been added 
since version 1607 such as Restart Options and Active Hours, and even the expanded metered 
connection settings, users will feel more empowered about getting updates for Windows 10. 

https://www.groovypost.com/news/microsoft-windows-10-update-services/ 

New Windows 10 accessibility features will improve many lives 
Mark Kaelin | February 7, 2017, 12:26 PM 

On February 1, 2017, Microsoft announced the release of Windows 10 Insider Preview Build 15025 
for PC to Windows Insiders in the Fast ring. While the build has been dubbed the primary build for 
the second Creator's Update Bug Bash, there is actually something more interesting about it than 
that. Build 15025 marks the addition and improvement of several accessibility features directly 
requested via customer feedback. 

One of the new features in Build 15025, and consequently one of the features Microsoft would like 
to see some feedback on, is braille support for Narrator. This will be an important feature addition to 
Windows 10 for the vision impaired. 

Updates in Windows 10 
In previous versions of Windows, users had total control over how they wanted their systems to 
update. You could have your system scan for updates automatically and install them straight away 
or when you chose, or you could manually look for updates periodically. Alternatively, you could turn 
the function off completely and never update your system. 

Whatever earlier version of Windows you currently owned, those are the options you had. But with 
Windows 10, that flexibility in choice changed. Depending on which version of Windows 10 you run, 
you’ll be on a specific service branch which will dictate how updates are handled. 
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For Windows 10 Home users, as well as people who upgrade to Windows 10 for free, all updates 
which includes security patches, bug fixes and new features–will be installed automatically. There is 
no choice to opt out of them or to delay their download. They’ll either be installed automatically or on 
the next manual system reboot (You can disable updates for Microsoft Office and other Microsoft 
programs). This is what Microsoft is calling the Current Branch (CB). 

Windows 10 Pro, has a toolbox of options. Even though the defaults are like those in Windows 10 
Home, Pro offers more control over your Windows Updates. The Windows 10 Pro Creators Update, 
for instance, lets you pause updates for up to 35 days. In current and previous releases, you could 
configure these options through the Group Policy editor; a feature that has always been exclusive to 
the Pro SKU. For most windows 10 users the pause option is a welcome addition.  

 

How to Check for and Install Windows 10 Updates  
Microsoft has made it easier for Windows Update to keep Windows 10 updated by automatically 
downloading and installing the latest features and improvements, drivers, and hotfixes released by 
Microsoft—and with fewer interruptions and restarts when you're using your PC the most. The latest 
updates will automatically download and install when they’re available. (Unless you’re on a metered 
connection, then updates won’t download until you manually check for updates.) 

http://www.makeuseof.com/tag/avoid-unnecessary-windows-reboot-shutdown/
https://www.tenforums.com/tutorials/8013-windows-update-automatic-updates-enable-disable-windows-10-a.html#option4
https://www.tenforums.com/tutorials/8013-windows-update-automatic-updates-enable-disable-windows-10-a.html#option4


Microsoft releases important updates every second Tuesday once a month, known as Patch 
Tuesday. However, updates could be released at any time. 

Windows 10 will automatically check for new Windows Updates at the time you have set in 
automatic maintenance and runs scheduled maintenance on a daily schedule when you're not using 
your computer. This feature was first introduced in Windows 8 

The Automatic Maintenance window allows you to select the time of day you want to run 
maintenance tasks, and are only run if your computer is not in use. In addition, you can allow the 
scheduled maintenance to wake up your computer when it is plugged in to run the maintenance 
tasks at the specified time. 

When Allow scheduled maintenance to wake up my computer at the scheduled time is selected 
(there is a check mark in the box), and you are running a laptop or a tablet on a battery, Automatic 
Maintenance will not wake up your system, preserving your battery power. However, if your 
computer is in Sleep mode while plugged in, Automatic Maintenance wakes up your computer and 
the maintenance tasks are performed using the full system resources so the tasks are performed as 
fast as the system can. After the system completes the maintenance tasks, it returns to Sleep mode. 

Automatic Maintenance includes such tasks as software updates, Windows Updates, security 
scanning, and system diagnostics. This maintenance will run daily if you aren't using your computer 
at the time you've chosen. If your computer is in use at the scheduled time or maintenance is behind 
schedule, Automatic Maintenance will run the next time the computer is not being used. 

The goal of Automatic Maintenance is to combine all background maintenance activity in Windows 
and help third-party developers add their maintenance activity to Windows without negatively 
impacting performance and energy efficiency. 

Here's How: 

1. Open the Control Panel (icons view), click on the Security and Maintenance icon. 

2. In Security and Maintenance, expand Maintenance, and click on the Change maintenance 

settings link under Automatic Maintenance. (see screenshot below) 

https://www.tenforums.com/tutorials/3090-automatic-maintenance-change-settings-windows-10-a.html
https://www.tenforums.com/tutorials/2691-control-panel-open-windows-10-a.html


 

3. Select the time that you would like to have Automatic Maintenance run daily at, then allow (check) 
or not allow (uncheck) Allow scheduled maintenance to wake up my computer at the 
scheduled time. When finished, click on OK. (see screenshot below) 

NOTE: By default, Automatic Maintenance is set to wake up your computer and run maintenance 
tasks at 2 AM. 

 

 

4. When finished, you can close Security and Maintenance if you like. 

https://www.tenforums.com/attachments/tutorials/8882d1417146596-automatic-maintenance-change-settings-windows-10-a-automatic_maintenance_settings-1.jpg
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This next tutorial will show you how to manually check for and install available updates in Windows 
Update for your Windows 10 PC. 

Here's How: 

1. Open Settings, and click on the Update & security icon. 

2. Click on Windows Update on the left side, and click on the Check for updates button. 

 

3. Windows will now check for updates (see screenshot below). 

https://www.tenforums.com/tutorials/3326-settings-open-windows-10-a.html
https://www.tenforums.com/attachments/tutorials/94093d1470317931-windows-update-check-install-windows-10-a-windows_10_check_for_updates-1.png


 

4. Windows will now automatically download and install any available updates.  

 

5. If there were problems installing any updates, click on Retry to try installing them again  

(see screenshot below).  

https://www.tenforums.com/attachments/tutorials/94094d1470317931-windows-update-check-install-windows-10-a-windows_10_check_for_updates-2.png
https://www.tenforums.com/attachments/tutorials/103260d1474910949-windows-update-check-install-windows-10-a-check_for_updates-3.jpg


 

6. If a restart has been scheduled to finish installing and applying available updates, then you either: 
click on Restart now, let Windows restart later (change active hours), or use a custom restart time. 

 (see screenshot below). 

https://www.tenforums.com/tutorials/56082-windows-update-use-custom-restart-time-windows-10-a.html
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You can also select to receive updates for other Microsoft products like Microsoft 
Office and also setup how updates are delivered to your PC. 

Here's How: 
1. Open Settings, and click on the Update & security icon.  

2. Click on Windows Update on the left side, and then click on the Advanced options link under 

Update settings (see screenshot below). 

https://www.tenforums.com/tutorials/44926-windows-updates-microsoft-products-turn-off-windows-10-a.html
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3. Check (turn on - default) or uncheck (turn off) the Give me updates for other Microsoft 

products when I update Windows box for what you want. 

 

https://www.tenforums.com/attachments/tutorials/89753d1468338745-windows-updates-microsoft-products-turn-off-windows-10-a-w10_updates_for_microsoft_products-1.png


4. Click on the Choose how updates are delivered link. 

 

Click Yes if prompted by UAC. link. 

1. Turn the toggle to right to get the updates from more than one place (PC on local network or 
PC on local network plus Internet). 

2. Turn the toggle to left to stop getting the updates from more than one place (PC on local 
network or PC on local network plus Internet). 

3. Click on "PC’s on my local network". 

  



How to Find Out Which Build and Version of Windows 10 You Have 
 “Windows 10” is apparently here to stay, and Microsoft won’t be bumping things up to Windows 11 
any time soon. Here’s how to find out what “build” of Windows 10 you have — you can think of it like 
a service pack level — as well as which edition and version of the operating system you have. 

Microsoft has hidden the build number attempting to make Windows 10 look always-up-to-date, and 
there are still different editions of Windows 10 with different features. Microsoft is also still offering 
both 64-bit and 32-bit versions of Windows 10, too. 

Use the Settings App 

The new Settings application also offers this information in a user-friendly form. To launch it, click or 

tap the Start button and select Settings. (see screenshot below). 

 

Navigate to System > About and scroll down. You’ll see the “Version” and “Build” numbers here. 

 Edition: The “Edition” line tells you which edition of Windows 10 you’re using — Windows 10 
Home, Professional, Enterprise, or Education. If you’d like to upgrade to Windows 10 
Professional, you can upgrade to the Professional edition from within Windows 10. 

 Build Number: Look at the “Version” and “OS Build” lines. If you have the original version of 
Windows 10, you’ll just see “OS Build 10240”. This was the initial release of Windows 10. If you 
have the “November Update” version of Windows 10 — Windows 10’s first big update — you’ll 
see a new version number scheme here. It’ll say “Version 1511 (OS Build 10576.29)”. 

The “1511” is the key. This number identifies that you’re using the build of Windows 10 released 
in November (the 11th month) of 2015. If Microsoft were to release a build of Windows 10 in 
April (the 4th month) of 2016, its version number would be “Version 1604”. 

 64-bit or 32-bit: The “System type” line tells you whether you’re using the 32-bit version of 
Windows 10 or the 64-bit version. It also tells you whether your PC is compatible with the 64-bit 
version or not. 

For example, “64-bit operating system, x64-based processor” indicates you’re using a 64-bit 
version of Windows 10 on a 64-bit processor. “32-bit operating system, x64-based processor” 
indicates you’re using a 32-bit version of Windows 10, but you could install the 64-bit version on 

your hardware if you preferred. (see screenshot below). 

http://www.howtogeek.com/236195/how-to-find-out-which-build-and-version-of-windows-10-you-have/
http://www.howtogeek.com/?p=235953
http://www.howtogeek.com/234946/how-to-upgrade-from-windows-10-home-to-windows-10-professional/
http://www.howtogeek.com/232176/whats-new-in-windows-10s-first-big-update-the-windows-10-fall-update/
http://www.howtogeek.com/56701/htg-explains-whats-the-difference-between-32-bit-and-64-bit-windows-7/
http://www.howtogeek.com/56701/htg-explains-whats-the-difference-between-32-bit-and-64-bit-windows-7/
http://www.howtogeek.com/228042/how-to-switch-from-32-bit-windows-10-to-64-bit-windows-10/
http://www.howtogeek.com/228042/how-to-switch-from-32-bit-windows-10-to-64-bit-windows-10/


 

Use the Winver Dialog and Control Panel 
You can use the old standby “Winver” tool to find the build number of your Windows 10 system. To 
launch it, you can tap the Windows key, type Winver” into the Start menu, and press Enter. You 

could also press Windows Key () + R, type “Winver” into the Run dialog, and press Enter. 

 

Winver will tell you which build of Windows 10 you have. Again, the version number is in the form 
YYMM, where 1511 means the 11th month of 2015. Latest version is v1607 OS Build 14393.726 

You’ll also see the edition of Windows 10 you’re using displayed in the Winver dialog. It states 

“Windows 10 Home” (see screenshot below). 



 

The Winver dialog doesn’t display whether you’re using a 64-bit or 32-bit version of Windows 10, but 
the Control Panel does. To open this screen, right-click “This PC” in a File Explorer window and 
select “Properties”. You can also open the Control Panel window, click “System and Security,” and 
then click “System”. 

 

The “Windows edition” section at the top of the window displays which edition of Windows 10 you’re 
using, while the “System type” line here displays whether you’re using a 64-bit or 32-bit edition of 
Windows 10, and whether your computer’s hardware is 64-bit compatible or not. 



 

This information is important if you want to know whether your Windows 10 machine has received 
an update yet, figure out if you have a feature available only in certain editions of Windows, or find 
out whether you should download the 64-bit version of a program or not. 

CNET - Computers 

Microsoft won't fix the most frustrating thing about Windows 
I asked a Microsoft spokesperson if the company was doing anything about forced updates. Here's 
the statement I got: 

Once a machine is upgraded to Windows 10, it will remain current through Windows Update for the 
supported lifetime of the device, with safety and security, productivity, and entertainment value over 
time. This is what we mean when we talk about delivering Windows as a service, and it is one of our 
core inspirations for Windows 10. We'll keep listening to our customers, improving the experience 
month after month. Windows 10 is an operating system that will run on a range of devices -- from 
Xbox to PCs, phones to tablets and tiny gadgets -- all of which are connected and kept up-to-date 
by Windows Update. Both enterprises and consumers benefit. The optimum way to ensure our 
customers are running the best Windows is to get them the latest updates for Windows 10. 
Delivering Windows 10 as a service means we can offer ongoing security updates, new features 
and capabilities - we'd like to make sure people can get access to the latest Windows 10 updates as 
soon as they are available. 

https://www.cnet.com/news/microsoft-windows-10-forced-updates-auto-restarts-are-the-
worst/?ftag=CAD5920658&bhid=24244554432464231393607109861960 

In other words, Microsoft thinks it's super important that you get the updates. "Auto-restarts" are a 
feature, not a bug. 

http://www.howtogeek.com/222458/should-you-upgrade-to-the-professional-edition-of-windows-10/
https://www.cnet.com/
https://www.cnet.com/topics/computers/
https://www.cnet.com/news/microsoft-windows-10-forced-updates-auto-restarts-are-the-worst/?ftag=CAD5920658&bhid=24244554432464231393607109861960
https://www.cnet.com/news/microsoft-windows-10-forced-updates-auto-restarts-are-the-worst/?ftag=CAD5920658&bhid=24244554432464231393607109861960


In fact, Microsoft has been actively getting rid of ways to keep users from disabling automatic 
updates: in Windows 10 Pro and above, you used to be able to do that from the Group Policy tool. 
As of the Windows 10 Anniversary Update, though, that option is gone.  

And while the next version of Windows will let you stave off updates for a 35-day period (if you paid 
extra for a Pro, Enterprise or Education-grade copy of Windows, which sounds like a moderate form 
of blackmail), my understanding is that even those versions won't let you cancel an update that's 
already been delayed and is now about to occur. 
(sean.hollister@cbsinteractive.com.) 

INFOWORLD: 
http://www.infoworld.com/article/3160527/microsoft-windows/why-microsoft-forced-windows-10-upgrades-last-
friday.html?idg_eid=08d5c964c9dce5ecf8376e4891b5c168&utm_source=Sailthru&utm_medium=email&utm_campaign
=InfoWorld%20Daily:%20Afternoon%20Edition%202017-01-23&utm_term=infoworld_daily 

WOODY ON WINDOWS By Woody Leonhard 

So far Windows 10 has appeared in three versions: 

 The original, RTM version (called 10240 and 1507), now at build 10240.17236 
 Fall Update version 1511 (later renamed November Update), now at build 10586.753 
 Anniversary Update version 1607, now at build 14393.693 

There's a fourth version, called Creators Update, expected in March or April. You can call it 1704. 

Microsoft has invented a conceptual superstructure of the versions that consists of the CB (Current 
Branch), the CBB (Current Branch for Business) and the LTSB (Long-Term Servicing Branch). See 
screenshot. 

 

You can read the formal description on Microsoft's website. The basic idea is that Win10 users bang 
around on the CB until Microsoft feels comfortable elevating the branch to CBB. Once a version is 
CBB-worthy, it's been thoroughly tested. Before that, well, you can draw your own conclusions. 

The "for Business" bit is a red herring as any Windows user who's sufficiently wily can hold off on 
installing upgrades until a CB version has been awarded CBB status. (LTSB is a different animal 
entirely, suitable for "Specialized systems – such as PCs that control medical equipment, point-of-
sale systems, and ATMs.") 

When you read jokes about unpaid beta testers, jokesters are referring to people who use a CB 
version of Win10 before it's granted CBB status. They are, in fact, running released versions of 
Win10 that haven't yet been certified as viable for Microsoft's most important customers. It's 
important to realize that "CBB" doesn't refer to a different version of Windows. It's simply a 
designation that this specific version of Win10 is ready for prime time. 

https://www.cnet.com/news/windows-10-will-allow-you-to-defer-updates/
http://www.infoworld.com/article/3160527/microsoft-windows/why-microsoft-forced-windows-10-upgrades-last-friday.html?idg_eid=08d5c964c9dce5ecf8376e4891b5c168&utm_source=Sailthru&utm_medium=email&utm_campaign=InfoWorld%20Daily:%20Afternoon%20Edition%202017-01-23&utm_term=infoworld_daily
http://www.infoworld.com/article/3160527/microsoft-windows/why-microsoft-forced-windows-10-upgrades-last-friday.html?idg_eid=08d5c964c9dce5ecf8376e4891b5c168&utm_source=Sailthru&utm_medium=email&utm_campaign=InfoWorld%20Daily:%20Afternoon%20Edition%202017-01-23&utm_term=infoworld_daily
http://www.infoworld.com/article/3160527/microsoft-windows/why-microsoft-forced-windows-10-upgrades-last-friday.html?idg_eid=08d5c964c9dce5ecf8376e4891b5c168&utm_source=Sailthru&utm_medium=email&utm_campaign=InfoWorld%20Daily:%20Afternoon%20Edition%202017-01-23&utm_term=infoworld_daily
http://www.infoworld.com/blog/woody-on-windows/
http://www.infoworld.com/author/Woody-Leonhard/
http://www.infoworld.com/article/3136336/microsoft-windows/woodys-win10tip-how-to-figure-out-your-windows-10-version.html
https://technet.microsoft.com/en-us/itpro/windows/manage/waas-overview?f=255
http://www.infoworld.com/article/3145396/microsoft-windows/microsoft-deems-windows-10-anniversary-update-enterprise-ready.html


How long between CB and CBB? Good question. For 1511 it was five months (from Nov. 10, 2015 
to Apr 8, 2016). For 1607 it took almost four months (from Aug. 2, 2016 to Nov. 29, 2016). 

There's a next step, after a version is deemed worthy of the CBB title. This is the one that tripped up 
people over the weekend. 

At some point after being declared CBB, Microsoft publishes the anointed version of Win10 to the 
Volume Licensing Service Center and republishes the version upgrade on the Windows Update 
server. The version itself doesn't change one iota. But the fact that it's published on those servers 
releases a cascade of actions that may not be obvious. 

Version 1607 was published last Friday, Jan. 19, or 62 days after it hit CBB. Microsoft's intentionally 
vague about how long they'll take to go from CBB to fully published. 

When Microsoft publishes the official CBB version: 

 Windows Update unhides the upgrade, if it was hidden with wushowhide. This is the way "hide" has 
always functioned in Windows Update: If there's a new version of a patch released (in this case, 
"Feature update to Windows 10, version 1607"), previous attempts to hide the patch get overridden. 

 Those who have "Defer Upgrades" checked in Windows Update (Start > Settings > Update & 
security > Windows Update) get upgraded to the next version, unless there's an update server such 
as WSUS or SCCM in the middle, or a Group Policy has been set to slow it down even more. The 
upshot is that most folks who were holding off 1607 by either using wushowhide or by checking the 
"Defer Upgrades" box in version 1511 had their choice overridden over the weekend. That came as 
quite a shock, with many people complaining about how their machines went down for the count. 

There's no way to predict how long a version will take to go from CB to CBB. There's no way to 
predict how long a version will take to go from CBB to fully published. We had no warning when 
1511 was published on the VLSC servers or when 1607 was published on the VLSC servers. 

For those of you who were upgraded and didn't want to be – sorry about the hour or two takeover of 
your machine – your best bet is to roll back the upgrade, then use either GPEdit (for those of you 
with Win10 Pro) or wushowhide to hide "Feature update to Windows 10, version 1607." 

Microsoft has another complex formula for determining when a release of Windows 10 will reach 
"end of life" – the point at which no more cumulative updates are offered. EOL occurs the later of 
either of the following: 

 Eighteen months after the version is released (which is to say, when it becomes Current Branch) 

 Sixty days after the next version is published to the VLSC server 

In this case, that means version 1507 – the original, RTM version of Win10 – will no longer be 
supported after March 20, 2017, the "60 days after next version is published" limit. The definitions, 
descriptions, settings, and durations are all evolving, and it looks like we'll have yet another bunch of 
changes for version 1704. 

  

https://blogs.technet.microsoft.com/windowsitpro/2017/01/19/windows-10-v1607-media-now-available/
http://www.infoworld.com/article/3105827/microsoft-windows/how-to-temporarily-block-the-upgrade-win10-anniversary-update-version-1607.html
http://www.infoworld.com/article/3138088/microsoft-windows/woodys-win10tip-block-forced-win10-updates.html
http://www.infoworld.com/article/3074096/microsoft-windows/hit-by-an-unexpected-windows-10-upgrade-heres-how-to-recover.html
http://www.infoworld.com/article/3138088/microsoft-windows/woodys-win10tip-block-forced-win10-updates.html
http://www.infoworld.com/article/3053701/microsoft-windows/block-windows-10-forced-updates-without-breaking-your-machine-part-2.html


How to Fix Windows Update When It Gets Stuck 

 

Windows Update is supposed to work silently in the background, but it may refuse to continue if it 
can’t install an individual update. 

This can happen on Windows 7, 8, or 10, but it’s become especially common with Windows 7. 
Sometimes updates will error out, or sometimes Windows Update may just get stuck “searching for 
updates” forever. Here are a few ways to give it a kick start. 

Windows 7, 8, and 10: Run the Windows Update Troubleshooter 

Windows includes a built-in troubleshooter that may be able to help fix a stuck update. It’s the 
easiest method to try, so go ahead and run it first. The troubleshooter performs three actions: 

1. It shuts down Windows Update Services. 
2. It renames the C:\Windows\SoftwareDistribution folder to C:\Windows\SoftwareDistribution.old, 

essentially clearing the Windows Update download cache so that it can start over. 
3. It restarts the Windows Update Services. 

This troubleshooter is available on Windows 7, 8, and 10. You’ll find it in the same place on all 
current versions of Windows. 

To run the troubleshooter, hit Start, search for “troubleshooting,” and then run the selection that 
search comes up with. 

http://www.howtogeek.com/247380/how-to-fix-windows-update-when-it-gets-stuck/


 

In the Control Panel list of troubleshooters, in the “System and Security” section, click “Fix problems 

with Windows Update.” (See screenshot below). 

 

In the Windows Update troubleshooting window, click “Advanced.”  

http://www.howtogeek.com/wp-content/uploads/2016/03/start_trouble_small.png
http://www.howtogeek.com/wp-content/uploads/2016/03/trouble_control.png


 

In the advanced settings, make sure that the “Apply repairs automatically” check box is enabled, 
click “Run as administrator” and then click Next. Giving the tool administrative privileges helps 

ensure that it can delete files in the download cache. (See screenshot below). 

 

http://www.howtogeek.com/wp-content/uploads/2016/03/wu_trouble_1.png
http://www.howtogeek.com/wp-content/uploads/2016/03/wu_trouble_2.png


The troubleshooter works through its process and then lets you know whether it could identify and 
fix the problem. Most of the time, the troubleshooter can successfully remove a stuck update from 
the queue. Go ahead and try running Windows Update again. Even if the troubleshooter says it 
couldn’t identify the problem, it’s possible that the actions of starting and stopping the service and 
clearing out the cache did the trick. 

This should hopefully become a bit easier in the future. In October 2016, Microsoft announced it was 
making changes to the way Windows 7 and 8.1 are “serviced”, or updated. Microsoft plans to 
release fewer small updates and more bundles of large updates. It will also begin combining 
previous updates into a monthly update rollup. This will mean fewer individual updates to install, and 
updating newly installed Windows 7 systems should become faster over time. 

Windows 10 install problems — and how to solve them 
Woody Leonhard Senior Contributing Editor, InfoWorld |FEB 16, 2017 

Windows 10 has been out for 18 months and many of you – some grudgingly, perhaps – have 
decided to upgrade. Often that goes smoothly. Sometimes, not so much, which is why we’re 
flagging the most common problems and how to deal with them. 

If your upgrade failed on the first try, take these three simple steps before you try again: 

 Disable antivirus and firewall – even Microsoft’s antivirus and firewall 
 Disconnect unnecessary USB-connected items: drives, modems, dongles, toasters, and so on 
 Reboot 

You’d be surprised how often an install will go through the second time, once your machine sheds 
its odd peripherals. 

Run a troubleshooter 

If you can’t figure out what’s wrong with your machine – that is, why an update doesn’t take – you 
should start with Microsoft’s downloadable troubleshooters. They don’t work all that frequently, but 
they’re easy to use and if you’re lucky can save you a lot of headache. 

Go to the Windows Update Troubleshooter page and download the Troubleshooter for your version 
of Windows. The downloaded file is called latestwu.diagcab. Double-click on it and you’ll see the 
Troubleshooter (see screenshot below). 

https://blogs.technet.microsoft.com/windowsitpro/2016/10/07/more-on-windows-7-and-windows-8-1-servicing-changes/
http://www.infoworld.com/author/Woody-Leonhard/
https://support.microsoft.com/en-us/instantanswers/512a5183-ffab-40c5-8a68-021e32467565/windows-update-troubleshooter


 

Click on the Advanced link, then click Run as Administrator. Click Next. The Troubleshooter will take 
a minute or two to scan your update files and settings. If it encounters any problems, it will fix them 
automatically. To see the results of the scan, click the link to View detailed information. Click Close, 
and the Troubleshooter disappears. Try running the upgrade again. 

Blast away temporary files 

If the Troubleshooter doesn’t catch the problem, there’s one more general trick you should try. 
Sometimes the hidden folder used to store upgrades (both Win7-to-Win10 and Win10 version-to-
version) can get corrupted. Corruption is bad in any form. Regardless of which version of Windows 
you’re using, try this: 

Step 1. Navigate to C: Look under This PC if you can’t find it immediately. 

Step 2. Show hidden files: I recommend you show hidden files all the time, In Win10, click View, 
then check the box marked Hidden Items. In Win7, click Folder Options, View, and under Advanced 
Settings check Show Hidden Files, Folders, and Drives. 

Step 3. Rename the folder called $WINDOWS.~BT: to $WINDOWS.WoodySaidZapIt or similar. 

Step 4. Run the update again: If the update works, simply delete the renamed folder 
$WINDOWS.WoodySaidZapIt. 

Sometimes cleaning out the SoftwareDistribution folder does the trick. Ask Woody Lounger jmwoods 
has detailed instructions for stopping the Windows Update service, renaming the 
SoftwareDistribution folder, then restarting Windows Update. 

You probably don't need a product key 

https://www.askwoody.com/forums/topic/ms-defcon-3-cautiously-update-windows-and-office/#post-78469


 

If you encounter a dialog like this one, insisting that you type in a product key, simply click Skip and 
don’t worry about it. Yes, the “free” upgrade to Windows 10 officially ended on July 29, 2016. No, 
the installer doesn’t enforce it: Win10 upgrades from genuine Win7 and 8.1 are still free as a breeze. 
Microsoft knows all about the nod-nod-wink-wink free upgrade lapse and hasn’t taken any steps to 
change it. 

If you’re upgrading from a “genuine” Windows 7 or 8.1 machine, click Skip, Do This Later, or Next 
(depending on the dialog box). Don’t bother trying to find a Windows 10 key. Chances are very good 
that Windows will recognize the error of its ways and not bother you again, although it may take a 
couple of days for the activation routine to figure it out. 

If you’re installing Win10 fresh – a clean install - you can type in any valid Win7 or 8.1 key and the 
Win10 installer will accept it. After all, it’s in Microsoft’s best interests to get everybody on Win10. 

If all else fails, and you’ve waited a few days (rebooting occasionally), try an automatic phone 
activation. Grab a pencil and a piece of paper. Press Windows key-R. Type: 

slui.exe 4 

(Note the space.) Hit Enter. Choose your country. You’ll receive a toll-free number and a 
horrendously long list of numbers known as the “installation ID.” Call the toll-free number and type in 
the installation ID. You will hear an automated voice give you an installation key. Write it down. Click 
Next on the slui dialog box and type in the numbers; you should be home free. 

If that doesn’t work, get on the phone and talk to a human. I’ve been working with phone activation 
for many years, and although there are a few notable exceptions, in almost every case, if you have 
a good story you’ll get a Windows 10 key. Tell the folks on the other end of the phone that you had a 

http://www.microsoft.com/en-us/licensing/existing-customer/activation-centers.aspx


genuine copy of Windows 7 or 8.1, but you used the Windows 10 Media Creation Tool to create a 
boot USB, then perform a clean install. 

If they suggest you reinstall Win7 or 8.1 and upgrade again, tell them it would be a pain in the neck 
because you’ve been using the system for several days. Sometimes a gentle request for a 
supervisor works. 

If the installer hangs for hours or reboots continuously 

First, make sure you’ve disconnected any nonessential hardware: Unplug all hard drives other than 
the C: drive. Yank that external hard drive and disconnect peripherals that aren’t absolutely 
necessary, including extra monitors, smart card readers, weird keyboards, whatever. If possible, 
turn off Wi-Fi and plug into a router with a LAN cable (that worked for me). 

Second, make sure you have the right upgrade: 32-bit for 32-bit machines, 64-bit for most. If you 
started with Windows 7 Starter, Home Basic or Home Premium, or Windows 8.1 (standard, usually 
called Home), you should install Windows 10 Home. If you started with Win7 Pro or Ultimate, or 
Win8.1 Pro or Pro for Students, you should install Windows 10 Pro. If you’re working with any 
enterprise version of Windows 7 or 8.1, the upgrade isn’t free -- it’s dependent on your Software 
Assurance license terms. 

Then try running the upgrade again. Doesn’t work? Try the steps in the preceding section to rename 
$WINDOWS.~BT and try again. 

If you continue to have the same problem, Microsoft’s best advice is to use the Windows 10 media 
creation tool to create a USB drive (or DVD). See the Download Windows 10 page for details. Be 
sure you follow the steps on that page, in order. 

Error: “Something Happened 0x80070005-0x90002” 

The Windows 10 installer has such descriptive error codes, doesn’t it?. The 80070005 error has 
been around for ages. It generally means the installer can’t work with a file it needs. Possible 
causes are many, but if you’re upgrading from Win7 or 8.1, you should first make sure you have the 
latest “Servicing stack update”. 

If you’re upgrading from Win7 to Win10, follow these instructions from Ask Woody Lounge luminary 
ch100 to get KB3177467 installed. It’s not easy. If you’re moving from Win8.1 to Win10, make sure 
you have KB3173424 installed. It isn’t as finicky as the Win7 Servicing stack update. With the latest 
Servicing stack in place, try running the upgrade again. 

Error 0xC1900101 

That’s a driver error. Microsoft has hit so many of them that it came up with a standalone support 
article to walk you through replacing the drivers. Pro tip: It’s complicated. 

Errors 0x8019001, 0x80070002, 0x87E105DC 

If you still can’t get the upgrade installed or you hit that 0x80070005 error when upgrading Windows 
10 versions, the general solution goes like this: 

1. Disable all antivirus and firewalls. Yes, even Microsoft’s. 
2. Check the Windows update guided walk-through. Microsoft says it will fix problems with error codes 

0x80073712, 0x800705B4, 0x80004005, 0x8024402F, 0x80070002, 0x80070643, 0x80070003, 
0x8024200B, 0x80070422, and 0x80070020. 

3. Run the Windows 10 installer again (presumably through Windows Update). 
4. If that doesn’t work, turn your AV and firewall back on, then follow the instructions at KB 947821 to 

run DISM or the System Update Readiness Tool. 
5. Turn off your AV and firewall, then try installing Win10 again. 

https://www.microsoft.com/en-us/software-download/windows10
https://www.askwoody.com/forums/topic/has-microsoft-finally-solved-the-windows-7-slow-update-problem/#post-13140
https://support.microsoft.com/en-us/help/3173424/servicing-stack-update-for-windows-8.1-and-windows-server-2012-r2-july-12,-2016
https://support.microsoft.com/en-us/help/10587/windows-10-get-help-with-upgrade-installation-errors
https://support.microsoft.com/en-us/help/10587/windows-10-get-help-with-upgrade-installation-errors
https://support.microsoft.com/en-us/help/10164/fix-windows-update-errors
https://support.microsoft.com/en-us/kb/947821


If that doesn’t work, try any or all of the suggestions listed here. 

If those don’t work, download the Win10 installation files using the Media Creation Tool, then 
perform a manual install. That will blast away anything you have on your PC – the nuclear option – 
but it usually works. If it doesn’t ... 

When the wheels fall off 

If you perform an in-place upgrade (not a clean install) to a new version of Windows 10 and act 
quickly enough, you can roll back to your previous version of Windows. If you went from Windows 7 
or 8.1 to Windows 10, you have 30 days to change your mind. If you went from Win10 November 
Update (Version 1511) to Win10 Anniversary Update (Version 1607), you have only 10 days. 

In either case, the method for rolling back is the same, but there are lots of possible gotcha’s. My 
February 2016 article on rollbacks covers many of them. 

Sometimes an upgrade goes positively terrible: black screens, blue screens, missing Start menu, a 
desktop that looks like a cow pie, nonfunctional apps, nonsensical error messages, and all sorts of 
variations thereof. That’s when you need to hunker down in the Windows Recovery Environment. 

Try booting into Safe Mode with Networking: 

Step 1a: Get to your Start menu, hold the Shift key down while you click Start, Power, Restart. 

Step 1b: If you can’t get to your Start menu, press Ctrl-Alt-Del, click Sign Out and, at the sign-in 
screen hold down the Shift key while you click the power button, then Restart. 

Step 2: Once you are in the Windows Recovery Environment, select Troubleshoot, then Advanced 
options, then Startup Settings, and Restart. (See screenshot below) 

 

http://answers.microsoft.com/en-us/insider/wiki/insider_wintp-insider_install/how-to-troubleshoot-common-setup-and-stop-errors/324d5a5f-d658-456c-bb82-b1201f735683
https://www.microsoft.com/en-us/software-download/windows10
http://www.infoworld.com/article/3033806/microsoft-windows/how-to-roll-back-your-windows-10-upgrade.html


Step 3. When it restarts, you should see a number of options (see above screenshot). Press 5 or F5 
for Safe Mode with Networking. 

Step 4. Once you sign into your account in Safe Mode, you may be home free. Restart your PC 
normally and see if that knocked Win10 upside the head. 

Step 5. If you’re still having problems, repeat Steps 1 to 4, and see if you can find the source of the 
problem. Drivers, in particular, can cause all sorts of calamitous events. If you are running antivirus 
software, uninstall it. You can always reinstall it when your machine is feeling better. 

As a last resort, add a new local administrator account (Start > Settings > Accounts > Family & other 
users > Add someone else to this PC) and reboot. 

Now's the time to patch Windows and Office 
WOODY ON WINDOWS – INFOWORLD - By Woody Leonhard – January 19, 2017 

If your system has multiple monitors and you run games with 3D rendering, be aware that this 
month's cumulative updates may mess up your second monitor. Microsoft announced that as a 
known issue with the following: 

 KB 3213986 for the Anniversary Update, version 1607, build 14393.693 
 KB 3210721 for the Fall (now "November") Update, version 1511, build 10586.753 
 KB 3210720 for the RMT version (now "1507"), build to 10240.17236 

However, I'm not at all sure the symptoms are caused by the patches. Be aware of the problem and 
if it happens to you, immediately uninstall the cumulative update. 

We still haven't shaken the dicey driver updates. Based on comments on AskWoody from abbodi86 
and ch100, it looks like the classic method for disabling driver updates in Group Policy doesn't work 
(see Shawn Brink's description on TenForums). The best advice I have at this point is to be aware of 
potential problems, make a full system backup before you run Windows Update, and if something 
goes kablooey -- you can't use a USB port, your audio stops working, your trackpad doesn't track -- 
use Device Manager (right-click Start > Device Manager) to roll back the bad patch. If you can't get 
the bad patch uninstalled, revert to the system backup and pray that better drivers come out next 
month. 

I've also seen continuing complaints about the latest cumulative update refusing to install. If you hit 
that problem, you can help Microsoft fix it by posting a description of the refusal on the Reddit 
Windows 10 forum and working with Microsoft support staff to run diagnostics and submit a report. 

With that warning, I say go ahead and take your medicine. Follow the steps in my Windows 10 Tip: 
Apply updates carefully. If you find KB 3199986, the "Servicing stack update for Windows 10 
Version 1607: October 27, 2016," you want to install it, also any Office, Flash, MSRT, or .Net 
updates. 

Or you can say "meh" and run Windows Update. May the Cumulative Force be with you. 

Don't install Adobe Reader patch 

Last week, I warned you about the latest Acrobat Reader DC patch, which automatically installs a 
Google Chrome spyware extension. According to @SwiftOnSecurity, "Adobe pushed this to 30 
million people through automatic updater without notice, without prompt, without mention in the 
changelog." Google security guy Tavis Ormandy says, "I took a quick look at the extension. There 
was an easy privileged JavaScript code execution bug. Sigh." Bottom line: Get rid of Acrobat 
Reader and, for heaven's sake, don't install a Reader patch if you find one. No, the Acrobat Reader 
patches don't go through Windows Update, but if you're in patching mode, you should triple-check it. 

http://www.infoworld.com/blog/woody-on-windows/
http://www.infoworld.com/author/Woody-Leonhard/
http://www.infoworld.com/article/3156974/microsoft-windows/win10-updates-kb-3213986-and-kb-3210721-have-multi-monitor-problems.html
https://www.askwoody.com/2016/how-to-roll-back-a-bad-driver-update/comment-page-1/
https://www.tenforums.com/tutorials/48277-driver-updates-windows-update-enable-disable-windows-10-a.html
https://www.askwoody.com/2016/get-those-full-system-backups-working/
https://www.reddit.com/r/Windows10/comments/5n6qgq/windows_10_build_14393693_released_for_all_pc_and/
https://www.reddit.com/r/Windows10/comments/5n6qgq/windows_10_build_14393693_released_for_all_pc_and/
http://www.infoworld.com/article/3143046/microsoft-windows/woodys-win10tip-apply-updates-carefully.html
http://www.infoworld.com/article/3143046/microsoft-windows/woodys-win10tip-apply-updates-carefully.html
https://support.microsoft.com/en-us/kb/3199986
http://www.infoworld.com/article/3157420/microsoft-windows/adobe-acrobat-reader-dc-security-update-installs-chrome-spyware.html
https://twitter.com/SwiftOnSecurity
https://twitter.com/taviso/status/821799140497584129


Much to Microsoft’s credit, I haven’t seen any catastrophic patches for Windows 10, although 
many—particularly forced driver changes and the aftermath to release of version 1607—have 
triggered plenty of alarm. But we haven’t seen any massive meltdowns caused by Windows 
patches, which was an all-too-common occurrence just a few years ago. 

Nowadays, the kinds of problems I see most frequently revolve around: 

 Cumulative updates that don’t install—typically they either hang indefinitely and/or install part way 
then automatically roll back to the previous version. 

 Drivers and/or settings and/or programs that get tossed into the vapor. 
 Updates that take place at the most inopportune times. 

If you judiciously block Win10 updates and wait a week or two to see if there are any problems that 
might affect you, if/when a big bug hits you’ll be in good shape. Here are the steps every Win10 user 
should take to make the most of their deferred updates. 

Step 1. If you turned off Windows Update, turn it back on. If you rely on metered connections to 
thwart automatic updates, skip to Step 2. 

There are many ways to turn off Windows Update but however you disabled it, you need to re-
enable it. 

Those of you who followed my instructions to turn off (or Defer) Updates in Step 3 of my Win10Tip 
on blocking forced Windows updates, go back into Group Policy editor and restore the settings to 
their original position. If you used dcomcnfg to turn the Windows Update service to Disabled, go in 
and Enable it. 

Reboot. Remember how you changed the settings, because you’ll want to reverse the steps and 
block automatic updates again once you finish this procedure. 

Step 2. Make sure the updates you don’t want are hidden, and vice-versa. This takes two runs of 
Microsoft’s 1990s-style wushowhide tool to get the hidden and unhidden patches sorted out. 

Step 2a. If you don’t already have wushowhide, go to KB 3073930 and download Microsoft’s 
Wushowhide tool. (Click the link marked “Download the ‘Show or hide updates’ troubleshooter 
package now.”) Drag the downloaded file, Wushowhide.diagcab, to any convenient location. 

Step 2b. Double-click on Wushowhide.diagcab to run it. 

Step 2c. This step is important, and not at all obvious: Click the link marked Advanced. Then 
uncheck the box marked “Apply repairs automatically.” Click Next. Wushowhide will run for a long, 
long time. When it comes back up for air, click the link to Show Hidden Updates. You see a list like 
the one in the screenshot. (See screenshot below) 

http://www.infoworld.com/article/2952996/microsoft-windows/on-the-road-to-windows-10-botched-nvidia-driver-tests-kb-3073930-patch-blocker.html
http://www.infoworld.com/article/3104999/microsoft-windows/windows-10-anniversary-update-woes-continue.html
http://www.infoworld.com/article/2889295/microsoft-windows/20-epic-microsoft-windows-auto-update-meltdowns.html
http://www.infoworld.com/article/3138088/microsoft-windows/woodys-win10tip-block-forced-win10-updates.html
https://support.microsoft.com/en-us/kb/3073930


 

Step 2d. This first run of wushowhide lets you unhide any patches you may have hidden in the past. 
Check the box next to any patches you want to install. In this case, I wanted to install the KB 
3200970 cumulative update for Win10 1607- this month’s cumulative update—so I check the box. 

I never want to install any drivers from Microsoft. I’ll go straight to the manufacturer’s website and 
even then, I’ll stay skeptical. (The recent experiences with Nvidia drivers, per Neowin, should make 
you skittish.) I adamantly refuse to install Microsoft’s obsolete Silverlight. Other updates may appear 
out of the blue, but in general I have no problem with installing the latest Windows Defender and 
Malicious Software Removal Tool, and thus check those, should they appear. 

Step 2e. Click Next. You see a list marked Select the repairs you want to apply. Click Next again. 
Wushowhide tells you that it’s “Resolving problems.” Wait a while for it to finish and click Close. 

Step 2f. Run wushowhide again, but turn the tables. Double-click on wushowhide, click the link 
marked Advanced. Then uncheck the box marked “Apply repairs automatically.” Click Next. 
Wushowhide will run for a long, long time. Click the link to Hide Updates. Check the boxes next to 
any updates that you don’t want to install. Click Next. 

Step 2g. You may see a list of “repairs you want to apply,” which means “hide these updates.” If you 
see it, click Next. Wushowhide is an odd bird, with an interface reminiscent of troubleshooters in 
Windows XP. If wushowhide successfully hid the upgrade/update/patch, you don’t get a confirmation 
screen. You only see a “Troubleshooting has completed” dialog. 

Step 3. If you set your Wi-Fi connection to metered, turn it back to not metered. 

Click the Notification area icon to the right of the time, down in the taskbar. At the bottom click 
Network. Then click on your current Wi-Fi connection and click Properties. (See screenshot below) 

https://www.neowin.net/news/psa-nvidia-game-ready-37586-drivers-cause-massive-performance-issues


 

Scroll down to the Metered connection slider like shown in the screenshot. Slide the setting Off. 

Step 4. Run Windows Update. 

Finally, we’re ready to install the update(s). Save everything. Click Start > Settings > Update & 
security. On the left, you see Windows Update. On the right, click the box marked Check for 
updates. 

Note: Once you click Check for updates, you don’t have to do anything more in order to install the 
update. “Check” in this case means “Install.” 

Windows may take a long time to find the update, and then take forever to install the update. You’ll 
likely need to reboot, although you can delay the reboot using the Change the active hours link on 
the right side of this panel. After the reboot, it may take forever to start again, waiting for updates to 
install. 



 

Step 5. You aren’t done yet. You need to re-block forced updates. If you have a Wi-Fi connection, 
that’s easy: Set it to metered. If you don’t have a Wi-Fi connection but you do run Win10 Pro, there 
are a couple of considerably more complex options that vary depending on which version of Win10 
you have: 1507, 1511, or 1607. I cover those in my Win10Tip Block forced Windows updates. And if 
you have Win10 Home with no Wi-Fi connection, you’re basically up the ol’ creek. 

Bonus tip: If you have Win10 Home and no Wi-Fi, buy and use a Wi-Fi dongle. 

If you can’t get a Windows 10 cumulative update to work, there are two important contact people at 
Microsoft who are very interested in hearing about your problem. They have direct links to the dev 
team and access to resources not available to mere mortals: 

 John Wink, who goes by /u/johnwinkmsft on Reddit and @johnwinkmsft on Twitter 
 Jen Gentleman, who is /u/jenmsft on Reddit and @JenMsft on Twitter 

Every time Microsoft rolls out a cumulative update for the latest version of Win10, you can find a 
thread on the Win10 Reddit that covers installation problems.  

  

http://www.infoworld.com/article/3138088/microsoft-windows/woodys-win10tip-block-forced-win10-updates.html
https://www.reddit.com/r/Windows10/


How to reset Windows 10 

1. Left-click on the Start button (Windows logo) to bring up the Start menu. 

Or just hit the windows key () and I key and skip to step 3 

 

2. Left-click on Settings (gear icon). 

 

3. Left-click on Update & security. 

 



4. In the left-hand column, left-click on Recovery. 

 

5. In the right-hand column under Reset this PC, left-click on the Get started button. 

 

6. On the Choose an option page, left-click on either Keep my files or Remove everything. 

o If you select Keep my files, you be prompted with a list of the apps you will need to 
reinstall. Left-click on the Next button to proceed. Once you left-click on your choice 
you'll come to the Ready to reset this PC screen. Left-click on Reset to proceed with 
the reset. 

o If you select Remove everything, you will be prompted to either Just remove my 
files or Remove files and clean the drive. Once you left-click on your choice you'll 
come to the Ready to reset this PC screen. Left-click on Reset to proceed with the 
reset. 

If you selected Remove files and clean the drive, when the reset is complete, you will need to go 

through the initial Windows 10 set up. Remember that you do not have to have a Microsoft account 

to complete the setup. When you get to the Who owns this PC? page, 

 

left-click on I own it and then left-click on the Next button. 



On the Make it yours page, left-click on the Skip this step link down in the lower left-hand corner. 

 

This will take you to the Create an account for this PC page where you can create a local user 

account. And remember that you are not required to have a password if you do not want to. Just add 

a user name in the Who is going to use this PC? field and then left-click on the Next button. 

Windows 7, 8, and 10: Fix Windows Update by Deleting Its Cache Manually 

If you’re still having trouble after running the troubleshooter (or if you’re the type that just likes to do 
things yourself), performing the same actions manually may help where the troubleshooter didn’t. 
We’re also going to add the extra step of booting into Safe Mode first, just to make sure that 
Windows can really let go of that cache of Windows Update downloads. 

Start off by booting Windows into Safe Mode. On Windows 7,restart your computer and press the 
“F8” key on your computer while it boots to access the boot options menu, where you’ll find a “Safe 
Mode” option. On Windows 8 and 10, hold down the Shift key as you click the “Restart” option in 
Windows and navigate to Troubleshoot > Advanced Options > Windows Startup Settings > Restart 
> Safe Mode. 

It’s a little more cumbersome than it used to be on the latest versions of Windows, but it’s still 
reasonably straightforward. Of course, if you want, you could also take some time to add Safe Mode 
to the Windows boot menu to make it easier in the future. 

http://www.howtogeek.com/107511/how-to-boot-into-safe-mode-on-windows-8-the-easy-way/
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http://www.howtogeek.com/245175/how-to-add-safe-mode-to-the-windows-8-and-10-boot-menu/


 

When you’ve booted into Safe Mode, the next step is to stop the Windows Update service, and the 
easiest way to do that is with the Command Prompt. To launch the Command Prompt in Windows 7, 
open the Start menu, search for “Command Prompt”, and launch the Command Prompt shortcut. 
You’ll also find it under Start > All Programs > Accessories > Command Prompt. In Windows 8 or 
10, you can right-click the Start menu (or press Windows + X), choose “Command Prompt (Admin)” 

and then click Yes to allow it to run with administrative privileges. (See screenshot below). 

 

At the Command Prompt, type the following command and then hit Enter to stop the Windows 
Update service. Go ahead and leave the Command Prompt window open. 

net stop wuauserv 



 

Next, open a File Explorer window and navigate to C:\Windows\SoftwareDistribution. 

Delete all the files in the folder. Don’t worry. There’s nothing vital here. Windows Update will 

recreate what it needs the next time you run it. (See screenshot below). 

 

Now, you’ll restart the Windows Update service. Return to the Command Prompt window, type the 
following, and hit Enter: 

net start wuauserv 

http://www.howtogeek.com/wp-content/uploads/2016/03/stop_wu.png
http://www.howtogeek.com/wp-content/uploads/2016/03/delete_files.png


 

When the service has restarted, you can close Command Prompt and restart Windows into normal 

mode. Give Windows Update another try and see if your problem has been fixed. 

Windows 7, 8, or 10: Download Updates Manually WSUS Offline Update 

If none of the official solutions fixed your problem, we have another solution that’s worked for us in 
the past. It’s a third-party tool called WSUS Offline Update. 

This tool will download available Windows Update packages from Microsoft and install them. Run it 
once, have it download those updates and install them, and Windows Update should work normally 

afterwards. This has worked in the past when the other solutions didn’t. (See screenshot below). 

Download WSUS Offline Update, extract it to a folder, and run the UpdateGenerator.exe application. 

 

Select the version of Windows you’re using –“x64 Global” if you’re using a 64-bit edition or “x86 
Global” if you’re using a 32-bit edition. After you do, click “Start” and WSUS Offline Update will 

download updates. (See screenshot below) 

http://download.wsusoffline.net/
http://download.wsusoffline.net/
http://www.howtogeek.com/wp-content/uploads/2016/03/start_wu.png


 

Wait for the updates download. If it’s a fresh install of Windows 7, there will be a lot of updates, so 
this may take quite a while. It depends on the speed of your Internet connection and how fast 
Microsoft’s download servers are for you. 

 



After the updates are done downloading, open the “client” folder in the WSUS Offline folder and run 
the UpdateInstaller.exe application.  

 

Click “Start” to install the downloaded updates. After the tool finishes installing the updates, 
Windows Update should work normally again. 

 

This should hopefully become a bit easier in the future. In October 2016, Microsoft announced that it 
was making changes to the way Windows 7 and 8.1 are “serviced”, or updated. Microsoft plans to 
release fewer small updates and more bundles of large updates. It will also begin combining 
previous updates into a monthly update rollup. This will mean fewer individual updates to install, and 
updating newly installed Windows 7 systems should become faster over time. 

https://blogs.technet.microsoft.com/windowsitpro/2016/10/07/more-on-windows-7-and-windows-8-1-servicing-changes/


Wi-Fi frequency, Wi-Fi Channel width, and wireless spectrum 
May 6, 2014 by Learn Tomato 

WiFi is a fascinating technology. It’s also one of those amenities like water and electricity –you just 
want it to work so you can flip a switch and enjoy the magic! The fact is, there are several things that 
can affect your Wi-Fi performance, such as: 

 Interference and obstructions 
 Wireless frequency 
 Frequency channel 
 Channel width 
 Wireless spectrum 
 Transmit Power 
 Antenna gain 
 Signal polarity 

Several things contribute to the overall performance of the network and If your WiFi is having issues 
it is often a symptom of interference that can be fixed with some minor tweaks. 

Wireless routers have radio transmitters built-in. In a Wireless LAN (WLAN) environment, a signal is 
broadcast from a radio transmitter and is received by a client device. Corresponding TCP/IP packets 
are sent back to the transmitter where they are routed either inside or outside of the network. 

In order to receive the broadcast and communicate with the transmitter, the client device must have 
a Network Interface Controller (NIC) capable of speaking the same language. When I say, “the 
same language” I’m referring to the same signal frequency and the same wireless spectrum. 

What is a Wireless Spectrum? 

Most wireless products use the following Wi-Fi spectrums: 802.11a, 802.11b, 802.11g, 802.11n, 
802.11ac. These Wi-Fi spectra are established by The Institute of Electrical and Electronics 
Engineers, a non-profit organization also known as the IEEE. This is why you’ll often see “IEEE 
801.11a/b/g/n” on retail boxes for wireless devices, routers, etc. 

 
Wireless Spectrum 

Contrary to the marketing hype, Wi-Fi spectrum is not based on speed alone. The frequency band is 
equally important. In fact, each frequency band has its own advantages and disadvantages. 

What is a Wi-Fi frequency band? 

There are basically two frequency bands used for Wi-Fi technology, 2.4GHz and 5GHz. The 2.4GHz 
has been around longer. It’s also an unregulated frequency. Therefore, vendors can manufacture 
2.4GHz devices less expensively than regulated spectrum like the 5GHz band. The downside to this 
“unregulated” band is that manufacturers use it for everything: cordless phones, baby monitors, 

http://learntomato.com/wifi-not-working-fix-slow-wifi-problems/


microwaves, garage door openers, etc. 5GHz is a regulated frequency which costs manufacturers 
more to produce. 

The 2.4GHz band offers better range. It handles obstacles better than 5.0GHz. However, 5GHz 
offers much faster throughput for maximum performance. It just doesn’t handle obstructions and 
channel noise quite as well. However, keep in mind that because there are more 2.4GHz wireless 
networks, the frequency channels can become crowded in some areas. 

Interference and obstructions greatly affect the range and quality of a wireless signal. Interference 
often comes from noise created by other wireless routers, cordless phones, baby monitors, etc. 
Obstructions are physical obstacles like walls and trees or large metal objects such as a refrigerator. 

Remember this when troubleshooting because it may not be just one thing causing problems. It 
could be that there are too many devices using the same frequency. It could also be multiple 
obstacles, inadequate antenna gain, or a little of everything. 

 
Frequency Interference 

What is Wi-Fi channel frequency? 

The 2.4GHz and 5GHz frequencies each have their own set of channels. You can usually choose 
“auto” or manually set channels within your router. Crowded channels produce low quality signals 
that lead to instability and intermittent connectivity problems. You can often increase signal quality 
by changing the channel. So, what is the “best” channel? 

In the following image, I’m using a software called inSSIDer (developed by MetaGeek.net) to survey 
the wireless broadcasts in the area. As you can see, the 2.4GHz frequency offers 11 channels to 
choose from, most of which are already in use by several neighbors nearby. 

A closer look reveals that some wireless SSID’s are using two “channels” and those that do, have 
higher “max rates” than the other networks. This dual channel scenario is known as “channel 
bonding.” Channel bonding bonds two channels together by increasing the channel width. 



 
Channel Width 

What is Wi-Fi channel width? 

Channel width basically controls how broad the signal is for transferring data. Think of it like a 
highway. The wider the road, the more traffic (data) can pass through. On the other hand, the more 
cars (routers) you have on the road, the more congested the traffic becomes. 

By increasing the channel width, we can increase the speed and throughput of a wireless broadcast. 
By default, the 2.4 GHz frequency uses a 20 MHz channel width. A 20MHz channel width is wide 
enough to span one channel. A 40 MHz channel width bonds two 20 MHz channels together, 
forming a 40 MHz channel width; therefore, it allows for greater speed and faster transfer rates. 

Obviously, two channels are better than one, right? In theory, yes. But not if those channels are 
crowded with noise and interference. In crowded areas with a lot of frequency noise and 
interference, a single 20MHz channel will be more stable. 40MHz channel width allows for greater 
speed and faster transfer rates but it doesn’t perform as well in crowded areas. 

However, noise and interference is not always the issue. Sometimes it’s the distance. If greater 
distance is the primary objective, my preference is the 2.4GHz band. 

If you discover that all of your neighbors are using the 2.4GHz band and your wireless performance 
is unreliable, first try changing the channel. Channels 1,6,11 are preferable for the 2.4Ghz band. 



 
Frequency Channels 

If after changing the channel, your connection is still unreliable, you may find it beneficial to “get 
away from the crowd” and use the 5GHz band. In the following image (still using the inSSIDer 
software from MetaGeek.net) you’ll see that on the 5GHz band I’m all alone. There are no other 
wireless SSID’s in the area. 

Therefore, even if 5GHz isn’t as strong at penetrating obstacles, the link quality is excellent because 
I’m the only one broadcasting on this frequency. This is like traveling on an open highway that no 
one else is using. 



 
5GHz band 

For most situations, the 5GHz band provides a more reliable connection. Not to mention that I had 
25 neighbors trying to share a handful of preferred channels on the 2.4GHz band. Granted, the 
range is not quite as far with 5GHz but it is acceptable throughout the entire building. 

Before you rush out and buy a new router, consider this: (1) It may not be necessary, and (2) If it is 
necessary, make sure you’ve got everything you need. 

First and foremost, it may not be necessary. If my area was not so crowded, I would have preferred 
to stick with my 802.11n, 2.4GHz, 40MHz channel width for a nice blend of both impressive speed, 
and maximum distance. Unfortunately, with so many access points nearby, changing the channel on 
my 2.4GHz band only helped temporarily. It worked like a charm until someone’s router hopped onto 
the same channel. When that happened, their broadcast created enough noise to disrupt 
communication between the router and the wireless card on my laptop. Bye-bye Internet connection. 

In addition to that, I would be better off choosing the 20Mhz channel width to decrease the amount 
of interference incurred by other devices. 40Mhz is best used with 5Ghz bands or uncrowded 
2.4GHz bands. 

In crowded areas, it can be a “battle of air space” to stabilize your network. In addition to changing 
channels, sometimes you can achieve more wireless stability by increasing the transmit power of 
your wireless broadcast. By increasing the transmit power, you are essentially increasing the 
voltage to the broadcast transmitter and ultimately “squelch” the neighboring broadcast with your 
own broadcast. Not all routers have this ability from the factory. In fact, this is one reason people 
often install custom firmware (like Tomato and DD-WRT) onto their router. 



Secondly, if the upgrade is necessary, make sure you’ve got the right stuff. In order to send and 
receive data packets on the 5GHz band, you’ll need two things: (1) a router capable of broadcasting 
5GHz signal, and (2) a 5GHz wireless network card installed on your client computer. 

These days, most smart phones and tablets have dual band Wi-Fi so they can connect wirelessly to 
either band. However, older laptops may only have 2.4GHz Wireless cards. So, even if you’re 
broadcasting a 5GHz signal, your laptop won’t be able to connect. The remedy? Buy a 5GHz 
Wireless USB adapter or replace the laptop’s single band wireless card with a dual band wireless 
card (one capable of handling both frequencies). 

How to Fix “Windows 10 Can’t Connect to This Network”? 

Solution 1 – Uninstall your network adapter 

If you can’t connect to wireless network on Windows 10, perhaps the problem is your wireless 
adapter, and it’s advised that you uninstall its drivers and allow Windows 10 to install them again. To 
do that, follow these steps: 

1. Press Windows Key + X and choose Device Manager from the list. 

 

2. When Device Manager starts, locate your network adapter and right click it. 

3. Choose Uninstall. If asked, check “Delete the driver software for this device” and click OK. 

 

http://windowsreport.com/wireless-network-not-connected-internet-works/
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4. After the driver, has been uninstalled, restart your computer and Windows 10 will 
automatically install the new driver. 

Solution 2 – Update your network adapter drivers 

Sometimes issues with wireless network are caused by outdated driver, and to fix “Windows 10 can’t 

connect to network” error you’ll have to download the latest drivers for your network adapter. To do 
this you’ll need a computer or any other device with working internet connection. You go to the 
website of your network adapter manufacturer and download the latest adapter drivers. 

Solution 3 – Change channel width for your network adapter 

“Windows 10 can’t connect to this network” message sometimes appears if the channel width of your 
wireless adapter isn’t set properly. To change the channel width, do the following: 

1. In Windows 8.1 and Windows 10 you can right-click the network icon, on the right side of the 
taskbar, then click or tap on "Open Network and Sharing Center". 

 

The other way is to go to "Control Panel -> Network and Internet -> Network and Sharing Center". 
This works in all versions of Windows. 

2. When the Network and sharing center opens, click Change adapter settings. 

 

3. Locate your wireless adapter and right click it. Choose Properties from the menu. 



 

4. When Properties window opens, navigate to Advanced tab. 

5. Select the 802.11 channel width and change the value. Some users have reported that 

changing the value to 20 MHz has fixed the issue for them, but you might have to use a 

different value. 

6. Click OK to save the changes. 

Solution 4 – Disable IPv6 on your computer and router 

To solve “Windows 10 can’t connect to this network” error, sometimes you have to disable IPv6 
network protocol. This do this in Windows 10, follow these steps: 

1. Open Network and Sharing Center. 
2. Find the Connections section and click your current connection. 

http://windowsreport.com/network-protocol-missing-windows-10/


 

  

http://cdn.windowsreport.com/wp-content/uploads/2016/03/connection-network-and-sharing-center.jpg


3. Connection status window will open. Click the Properties button. 

 

4. Find Internet Protocol Version 6 (TCP /IPv6) and uncheck it. 

 

5. Click OK button to save the changes. 
6. Restart your computer to apply the changes. 

If the problem persists, you might have to disable IPv6 on your router. Disabling IPv6 on your router 
is a complicated process, and it’s different for every type of router, so before you do that, check your 
router’s instruction manual. 

  

http://cdn.windowsreport.com/wp-content/uploads/2016/03/disable-ipv6.jpg


Solution 5 – Make sure that your adapter and router use the same security type. 

To protect your data, wireless connections come with certain security types such as WPA2-PSK 
(AES) or WPA-PSK (AES). If your network connection is to work properly, your router and computer 
need to use the same security type. You can set the security type for your router by following the 
instructions from your router’s instruction manual. 

After you’ve set a specific security type on your router, you need to check if the same security type 
is being used on your computer as well. To do that, you need to follow these steps: 

1. Open Network and Sharing Center and click Manage wireless networks. 
2. Find your wireless network, right click it and choose Properties. 
3. Go to the Security tab, find the Security type section and select the same security type your 

router is using. You might have to go thru several security types before you find the right one. 
4. Click OK to save your changes. 

Solution 6 – Add the connection manually 

1. Open Network and Sharing Center. 
2. Click Set up a new connection or network. 
3. Choose Manually connect to a wireless network and click Next. 
4. Enter the requested information such as network name, security key and security type. 
5. Click Next to finish the process. 

After you’ve created a new network connection, everything should be working without any problems. 
If the issue persists, try changing the security type of your new network. 

Solution 7 – Change the wireless network mode 

You can change the wireless network mode for your router and your wireless adapter, and to make 
your network work properly, your router and network adapter need to use the same or similar 
network mode. If you want to change the network mode of your router, you’ll need to check the 
instruction manual, but in most cases it won’t be necessary to change the wireless network mode on 
your router. To change the network mode on your computer, follow these steps: 

1. Open Network and Sharing Center. 
2. Click Change adapter settings, locate your wireless network adapter, right click it and 

choose Properties from the menu. 

  



3. When the Properties window opens, click the Configure button. 
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4. Go to the Advanced tab and from the list select Wireless mode. 

 

5. Now change the value of Wireless mode so it matches the value of Wireless mode on your 
router. In most cases 802.11b (or 802.11g) should work, but if it doesn’t, try experimenting 
with other options. 

Solution 8 – Forget the wireless connection 

If you’re having “Windows 10 can’t connect to this network” error, you might want to “forget” your 
wireless connection in order to fix this problem. To forget wireless network on Windows 10, do the 
following: 

1. Open Settings App and go to Network & Internet. 
2. Go to Wi-Fi section and click on Manage Wi-Fi settings. 
3. Scroll down to the Manage known networks, select your Wireless network and click Forget. 
4. After you’ve done that, connect to the same wireless network again. 

Solution 9 – Disable and enable your wireless connection 

To fix the “Windows 10 can’t connect to this network” error, sometimes you just need to disable your 
connection and enable it again. To do that, follow these steps: 

1. Open Network and Sharing Center. 
2. Click Change adapter settings. 
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3. Locate your wireless connection, right click it and choose Disable. 

 

4. Right click the same connection again and choose Enable. 

Solution 10 – Install the driver manually 

Sometimes the “Windows 10 can’t connect to this network” error is caused by a bad driver, and you 
might have to manually install the driver to fix this error. To do that, follow these steps: 

1. Open Device Manager and find your network adapter. 
2. Right click it and choose Update Driver Software. 

 

3. Click Browse my computer for driver software. 
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4. Now click on Let me pick from a list of device drivers on my computer. 

 

5. Make sure that Show compatible hardware is not checked. 

 

6. Find your network adapter manufacturer and select the driver you wish to install. 
7. After you’ve installed the driver, restart your computer. 

Solution 11 – Use ipconfig /release command 

If the “Windows 10 can’t connect to this network” message is preventing you from accessing 
internet, you can try to fix it by using the Command Prompt. To do that, follow these steps: 
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1. Press Windows Key + X and from the list choose Command Prompt (Admin). 

 

2. When Command Prompt starts, enter the following lines and after each line press Enter: 

o ipconfig /release 
o ipconfig /renew 

3. Close Command Prompt and try to connect to the network again. 

Solution 12 – Change your network adapter 

If nothing else works, maybe you should change your network adapter. Certain USB WiFi adapters 
aren’t compatible with Windows 10, and if that’s the case, you might have to replace your current 
adapter with a newer model. 

Fix – Windows 10 can’t connect to this network after upgrade 

Solution 1 – Use Command Prompt 

Some users are reporting that they are getting “Windows 10 can’t connect to this network” message 
after upgrade, and if you are having the same problem, you might want to try the following solution: 

Open Command Prompt as administrator. 
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When Command Prompt starts, type the following and press Enter to run. 

  reg delete HKCR\CLSID\{988248f3-a1ad-49bf-9170-676cbbc36ba3} /va /f 

 

1. Now enter the following line and press Enter to run it: 

 netcfg -v -u dni_dne 

 

2. Close Command Prompt and restart your computer. 

Solution 2 – Uninstall ESET Smart Security / antivirus software 

“Windows 10 can’t connect to this network” error can be caused by your antivirus, and users have 
reported that ESET Smart Security is associated with this error. Users indicate, sometimes their 
Ethernet card might not be detected, so you’ll have to uninstall ESET Smart Security. To do that, 
follow these steps: 

1. Open Settings and choose System. 
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2. Go to Apps & features section. 

 

3. Locate your ESET Smart Security software and click Uninstall. 

4. Restart your computer. 

If you don’t use ESET Smart Security, you might want to uninstall the antivirus software that you’re 
currently using. Users have reported that other antivirus software such as BitDefender or Comodo 
firewall can also cause this issue. If your network connection starts working, you can install your 
antivirus software again. We also need to mention that some users suggest that you must uninstall 
your Ethernet driver as well, to fix this issue. 

Solution 3 – Check if IPv4 and IPv6 protocols are enabled 

In some cases IPv4 and IPv6 protocols might get disabled after upgrade, and that can cause 
“Windows 10 can’t connect to this network” error. To fix this issue, you need to do the following: 

1. Open Network and Sharing Center. 
2. Click Change adapter settings. 
3. Find your adapter, right click it and choose Properties. 
4. Make sure that IPv4 and IPv6 protocols are enabled. 
5. Click OK and check if the issue has been resolved. 
6. If the issue persists, repeat all the steps but this time enable all items in Properties window. 

Fix Windows 10 can’t connect to this network, enter an APN and try again 

Solution – Enter new Internet APN 

In most cases Internet APN is automatically set on your phone, but if for some reason your mobile 
data connection isn’t working, you might need to contact your mobile provider and ask it for APN 
information. 
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To add APN on your phone, do the following: 

1. Tap on Mobile network + SIM settings. 

2. Choose SIM settings > Add Internet APN. 

3. Now you’ll need to enter APN information. 

4. After you’re done, click on Save. 

Like we said, you might have to contact your mobile provider to get your APN information, or you 
can search for it online from a different device. 

Fix Windows 10 can’t connect to this network and WEP problems 

Solution – Create connection manually 

We have already covered how to create a wireless connection manually in this article, but to 
connect to a network that uses WEP security, you have to set Security type to WEP for your new 
connection. We should also mention that WEP security type isn’t the safest, and it’s advised that 
you switch to WPA2 security type. To do that, you’ll have to change Security type in your router and 
on your computer. 

Fix Windows 10 can’t connect to this network after waking from Sleep 

Solution 1 – Disable IPv6 / Change Power Management settings 

We have already described how to disable IPv6 in this article, but if you’re getting “Windows 10 can’t 
connect to this network” message after your computer wakes up from Sleep Mode, you need to 
check the Power Management settings for your adapter. To do that, follow these steps: 

1. Open Device Manager and navigate to the Network Adapters section. 

2. Locate your wireless adapter and right click it. Choose Properties from the menu. 

 

3. Navigate to the Power Management tab. 
  

http://windowsreport.com/fix-issues-sleep-mode-windows-8-1/
http://cdn.windowsreport.com/wp-content/uploads/2016/02/properties-driver.jpg


4. Uncheck Allow the computer to turn off this device to save power and save the changes 

 

If you use USB network adapter, you’ll have to repeat this step for all USB devices in Device 
Manager. 

Solution 2 – Change Power Options 

1. Press Windows Key + S and type Power Options. Choose Power Options from the list. 
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2. When Power Options window opens, find your selected power plan and click the Change 
plan settings. 

 
3. Now click Change advanced power settings. 

 

4. Navigate through the list and go to Wireless Adapter Settings > Power Saving Mode. 



5. Change its Setting to Maximum Performance and save the changes. 

 

If this solution doesn’t work, you can also try changing your power plan to High Performance. To do 
that, follow these steps: 

1. Open Power Options. 
2. Select High performance power plan. 
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Solution 3 – Turn off Connect to WiFi hotspots 

If you’re getting “Windows 10 can’t connect to this network” message after waking from Sleep Mode, 
you might want to disable few Wi-Fi settings. To do that, follow these steps: 

1. Open Settings and go to Network & Internet. 
2. Go to Wi-Fi and click on Manage Wi-Fi settings. 
3. Make sure that “Connect to Wi-Fi hotspots” and “Send information about Wi-Fi 

connections to help discover nearby Wi-Fi” are turned off. 

Solution 4 – Disable/enable your network connection, turn on/off Airplane mode 

To properly fix “Windows 10 can’t connect to this network” error, you need to first disable and enable 
your network connection. Then turn Airplane mode on and off, to see if this will correct the problem. 

Fix – Windows 10 can’t connect to this network after password change 

Solution – Forget your network, delete your network from Preferred networks 
list, check your security type 

If you’ve recently changed your password for wireless network and now you’re getting “Windows 10 
can’t connect to this network” message, you can “forget” your network. In addition, you need to 
check if your security type on your computer matches the security type on your router.. 

To delete your network from the Preferred networks list, do the following: 

1. Open Network and Sharing Center. Choose Change adapter settings. 
2. Locate your wireless adapter and right click it. Choose Properties from the menu. 
3. Click the Configure button and go to Wireless Networks tab. 
4. Delete your network from the Preferred networks list. 
5. Save the changes. 
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